
Предисловие, Содержание

Суть CFC 1

Первые шаги 2

Работа средактором CFC 3

Тестирование и ввод в
эксплуатацию

4

Документирование 5

Приложения

Технические спецификации A

Сокращения B
Словарь, Указатель

SIMATIC

CFC для S7
Непрерывные
функциональные схемы

Руководство

Редакция 01/2003
A5E00177297-01



Copyright © Siemens AG 2003 Все права сохраняются
Воспроизведение, передача или использование этого
документа или его содержания не допускается без
специального письменного разрешения. Нарушители
будут нести ответственность за нанесенный ущерб. Все
права, включая права, создаваемые патентным грантом
или регистрацией сервисной модели или проекта,
сохраняются.

Siemens AG
Департамент техники автоматизации и приводов
Сфера деятельности: промышленные системы автоматизации
п/я 4848, D- 90327 Нюрнберг

Отказ от ответственности
Мы проверили содержание этого руководства на
соответствие с описанной аппаратурой и
программным обеспечением. Так как отклонения
не могут быть полностью предотвращены, мы не
гарантируем полного соответствия. Однако
данные, приведенные в этом руководстве,
регулярно пересматриваются и необходимые
исправления вносятся в последующие издания.
Приветствуются предложения по улучшению.

©Siemens AG 2003
Технические данные могут изменяться.

Акционерное общество Siemens A5E00177297-01

Указания по безопасности

Это руководство содержит указания, которые вы должны соблюдать для обеспечения собственной безопасности, а
также защиты продукта и подключенного оборудования. Эти указания выделены в руководстве предупреждающим
треугольником и помечены следующим образом в соответствии с уровнем опасности:

! Опасность
Указывает, что несоблюдение надлежащих предосторожностей приведет к смерти, тяжким
телесным повреждениям или существенному повреждению имущества.

! Предупреждение
Указывает, что несоблюдение надлежащих предосторожностей может привести к смерти,
тяжким телесным повреждениям или существенному повреждению имущества.

! Предостережение
Указывает, что несоблюдение надлежащих предосторожностей может привести к небольшим
телесным повреждениям или порче имущества.

Замечание
Привлекает ваше внимание к особенно важной информации о продукте, обращении с
продуктом или к определенной части документации.

Квалифицированный персонал

К установке и работе на данном оборудовании должен допускаться только квалифицированный персонал. К
квалифицированному персоналу относятся лица, имеющие право пускать в эксплуатацию, заземлять и маркировать
электрические цепи, оборудование и системы в соответствии с установленным порядком и стандартами.

Правильное использование

Примите во внимание следующее:

! Предупреждение
Это устройство и его компоненты могут быть использованы только для приложений, описанных
в каталоге или технических описаниях, и только в соединении с устройствами или
компонентами других производителей, которые были одобрены или рекомендованы фирмой
Siemens.

Этот продукт может правильно и безопасно функционировать только при правильной
транспортировке, хранении, установке и инсталляции, а также эксплуатации и обслуживании в
соответствии с рекомендациями.

Торговые марки

SIMATIC®, SIMATIC HMI® и SIMATIC NET® являются зарегистрированными торговыми марками SIEMENS AG.

Некоторые из других обозначений, использованных в этих документах, также являются зарегистрированными
торговыми марками; права собственности могут быть нарушены, если эти обозначения используются третьей
стороной для своих собственных целей.
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Предисловие

Цель руководства
Это руководство по “CFC для S7” обеспечивает Вас информацией, которая
требуется для использования инструмента конфигурации CFC при
программировании CPU в программируемых контроллерах SIMATIC S7.
Для полного описания CFC для других систем, Вам так же потребуются
вспомогательные описания CFC для конкретных систем (например, "CFC для
M7", "CFC для SIMADYN D").

Как обозначаются разделы для определенных систем
Если раздел, параграф или даже отдельное предложение в этом
руководстве связаны исключительно с пользователями S7, они обозначаются
[S7]. Это означает, что информация применима только для S7 или она
отличается для других систем. В этом случае, если Вы используете
различные PLC, Вы можете найти информацию которая Вам требуется в
руководстве для Вашей определенной системы. Если [S7] обозначает
заголовок, весь раздел применим только для S7, если это обозначает начало
параграфа, параграф применим исключительно для S7. В листе означает
применимость только к конкретному листу.

Аудитория
Это руководство предназначено для персонала имеющего дело с
конфигурированием, запуском и обслуживанием.

Применимость
Это руководство действительно для программного обеспечения CFC версии
6.0 и выше.

Стандарты
Программное обеспечение CFC основано на международном стандарте DIN
EN 61131-3 (IEC 1131-3) для языков программирования программируемых
логических контроллеров.

Conventions Соглашения
Ссылки на другие документы обозначены числом в скобках /.../.
Воспользовавшись номером, Вы можете проверить полный заголовок
документации в разделе Ссылки в конце руководства.
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Дальнейшая поддержка
Если у Вас есть, какие либо технические вопросы, пожалуйста, свяжитесь с
вашим представительством Сименса или ответственным агентом.

http://www.siemens.com/automation/partner

Обучающие центры
Сименс предлагает ряд учебных курсов для знакомства Вас с
автоматизированной системой SIMATIC S7. Пожалуйста контактируйте с
вашим региональным учебным центром или с нашим головным учебным
центром D 90327 Nuremberg, Germany для уточнения.
Telephone:  +49 (911) 895-3200.
Internet: http://www.sitrain.com
В России: (095)-737-23-88 Екатерина Севиева
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Техническая поддержка A&D
Всемирная, круглосуточная:

 

Beijing

Nuernberg

Johns on City

Всемирная (Nuernberg)
Техническая поддержка

24 часа, 365 дней в году

Phone: +49 (0) 180 5050-222

Fax: +49 (0) 180 5050-223

E-Mail: adsupport@
siemens.com

GMT: +1:00

Европа / Африка (Nuernberg)
Авторизация

Местн. время: Пон.-Пт. 8:00 - 17:00

Phone: +49 (0) 180 5050-222

Fax: +49 (0) 180 5050-223

E-Mail: adsupport@
siemens.com

GMT: +1:00

США (Johnson City)
Техническая поддержка и
авторизация
Местное время: Пон.-Пт. 8:00 - 17:00

Phone: +1 (0) 423 262 2522

Fax: +1 (0) 423 262 2289

E-Mail: simatic.hotline@

sea.siemens.com

GMT: -5:00

Азия/ Австралия (Beijing)
Техническая поддержка и
авторизация
Мест. время:Пон.-Пт.8:00 -17:00

Phone: +86 10 64 75 75 75

Fax: +86 10 64 74 74 74

E-Mail: adsupport.asia@

siemens.com

GMT: +8:00

Горячая линия SIMATIC и авторизации работает на немецком и английском языках
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Service & Support on the Internet
In addition to our documentation, we offer our Know-how online on the internet at:
http://www.siemens.com/automation/service&support

where you will find the following:

• The newsletter, which constantly provides you with up-to-date information on
your products.

• The right documents via our Search function in Service & Support.

• A forum, where users and experts from all over the world exchange their
experiences.

• Your local representative for Automation & Drives via our representatives
database.

• Information on field service, repairs, spare parts and more under "Services".
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1 Суть CFC

Введение
Эта глава дает основную информацию о CFC, показывает, как он
интегрирован в программный пакет STEP 7, описывает представление
блоков, и объясняет шаги, которые требуются для создания структуры
проекта и для тестирования программы.

Для описания инсталляции, авторизации и запуска программного
обеспечения CFC, прочитайте файл readme в пакете CFC.

1.1 Общее

Что такое CFC?
CFC (Непрерывные Функциональные схемы) - это графический редактор,
дополнительный к пакету STEP7. Он используется для создания из
предварительно подготовленных блоков структуры в целом программы для
CPU (процессора). При работе с редактором Вы можете объединить блоки в
функциональные схемы, назначить им параметры и соединить их.

Соединения показывают, что величины переменных передаются от одного
выхода блока к одному или более входам других блоков.

Как работает пакет
В редакторе CFC, Вы работаете с графическими инструментами: Вы
выбираете готовые блоки из совокупности блоков, помещаете их в схему (как
бы на чертежной доске) и соединяете их с помощью мыши. Вам не требуется
вникать в детали, такие как алгоритмы или использование машинных
ресурсов, что позволяет полностью сосредоточиться на технологических
аспектах Вашего проекта.

Рабочие свойства блоков имеют установки по умолчанию, но их можно
индивидуально настроить под каждый блок. Возможность копирования или
перемещения отдельных блоков или целых групп между схемами сделают
вашу работу намного проще. Соединения между блоками при этом
сохраняются.

После того как все функции написаны, Вы можете сгенерировать
исполняемый машинный код, загрузить его в программируемый контроллер и
проверить его на наличие ошибок с помощью тестовых функций CFC.
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1.2 [S7] CFC в оболочке STEP 7

SIMATIC Manager
SIMATIC Manager  используется как графический интерфейс для всех PLC и
служит для координации приложений и объектов. Он управляет различными
инструментами и данными, например, используется для создания и
изменения структуры проекта (CPU, CFC схем), а также для запуска
редактора CFC.

AS3xx
AS4xx

SIMATIC Manager

CFC
STEP 7 Tool

WinCC

OS

Рисунок 1-1: CFC в оболочке STEP 7

Остальные компоненты
В зависимости от PLC, Вы можете использовать такие компоненты, как
различные языковые пакеты для создания типов блоков, и инструменты для
создания входных данных схем CFC таких, как входные и выходные данные,
на которые можно будет ссылаться из CFC.
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1.3 Схема CFC

Следующий раздел описывает схему CFC и ее элементы, устанавливает
терминологию.

Схемы и части схемы
Основной рабочий модуль редактора CFC  - это схема (Chart). Каждая схема
имеет имя, уникальное для CPU. Вы можете создать схему или в SIMATIC
Manager или непосредственно в редакторе CFC.

Каждая часть схемы содержит до 26 разделов (partition). Вновь создаваемая
схема состоит из одного раздела, остальные могут добавляться по мере
необходимости.

Лист и панель листа
Каждый раздел схемы состоит из шести листов (sheet), располагающихся в
две колонки по три листа в редакторе CFC (см. Рисунок 1-2). Лист состоит из
центральной рабочей площади и панелей листа (sheet bar), содержащих
ссылки листов и схем. На рабочей поверхности Вы можете размещать и
соединять блоки или дополнительные схемы.

Страницы переполнения
Если было создано так много соединений c другими листами, что они не
уместились на панели листа, то автоматически формируется страница
переполнения. Страница переполнения является простым расширением
интерфейсных панелей листа и не может содержать никаких других
элементов.

Вложенные схемы
Схема CFC может быть вставлена в другую схему CFC (техника схема-в-
схеме). Это позволяет создать иерархичную структуру. Каждая вложенная
схема может открываться, как и другая схема, редактироваться и
индивидуально изменяться.

Схема может быть “инкапсулирована" для дальнейшего использования;
другими словами, имеет входы и выходы. Для каждой схемы, Вы можете
решить, какие входы и выходы блоков доступны как входы и выходы схемы.

Для более подробной информации о вложенных схемах, используйте
руководство, Глава 3 или смотрите интерактивную справку.
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Обзор схемы и просмотр листа
В конкретный момент времени Вы можете выбирать между режимами обзора
схемы и просмотра листа.

Режим обзора всей схемы оптимален для копирования и перемещения
блоков и схем, а также для вставки больших блоков. Однако, так как
некоторые детали не могут быть показаны в этом режиме, например имена
входов и выходов, Вы можете выполнить определенные функции только в
режиме просмотра конкретного листа. Вы можете использовать функции
изменения размера изображения на экране, чтобы вывести лист схемы
целиком вместе с граничными панелями.

Обзор схемы
Вы можете вывести различные элементы схемы. Для блоков, например, Вы
можете решить, показывать ли в заголовке блока имя типа или назначенный
номер FB/FC, показывать ли для входов и выходов тип данных и имя или
комментарии. Ширина блоков и граничной панели листа - переменные.
Для более детальной информации смотрите интерактивную справку.

Пример обзора схемы
Рисунок 1-2 показывает пустую схему CFC (6 листов) в режиме обзора.

 

Лист 1

Лист 2

Лист 3 Лист 6

Лист 5

Лист 4

Центральная рабочая область Панель листа 

Рисунок 1-2: Схема CFC в режиме обзора
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Пример просмотра листа
Рисунок 1-3 показывает просмотр листа схемы CFC с 4 соединенными
блоками:
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BO COM_RST
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RE GAIN
RE LMNR_HLM_

TI TM_LAG1
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OUTV RE
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W PV_PER
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RESP_INT
TICYCLE

BOLMNDN

BOLMNR_ON
BOLMNUP
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QLMNUP BO
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PV RE
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Рисунок 1-3Схема CFC в режиме просмотра листа
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1.4 Блоки в CFC

Функции в форме блоков
В CFC, Вы работаете с заранее подготовленными блоками, которые
реализуют конкретные алгоритмы. Вы помещаете эти функциональные блоки
в схему, соединяете их и задаете параметры.

Тип блока
Определение типа для каждого функционального блока задает алгоритм, имя
и интерфейс данных (входные и выходные параметры).

Имя типа - это сокращение или акроним функции, например:

− CTUD (COUNT UP и DOWN) для управляемой фронтами функции
счета вверх и вниз.

− COUNT_P, счетчик, который считает в прямом или обратном
направлении (в зависимости от установок) при положительном фронте
бинарного сигнала.

− ADD_R, простая функция, которая складывает входные величины и
выдает сумму на выход.

Описание типа также определяет типы данных входных и выходных
параметров. Эти параметры известны как входы и выходы блока при
графическом представлении блока.
Тип данных входа и выхода определяется тем, какую величину он может
принять, например,
BOOL Булевский тип, может принимать только значения  0 или 1,
STRING символьный строковый тип, может содержать строку символов.
Другие типы данных описаны в Приложении, Таблица A-2.

Экземпляр блока
Как только Вы помещаете блок в Вашу схему CFC, Вы создаете экземпляр
для этого типа блока. Экземпляр в этом значении – каждое использование
выбранного типа блока.

Вы можете создать любое количество экземпляров блока одного типа. Вы
можете назначать имена этим экземплярам, соединять их и назначать им
параметры без изменения функциональных спецификаций данного типа
блока.

Преимущества экземпляра типа, в частности, в том, что последующие
изменения в типе блока будут автоматически выполнены во всех
соответствующих экземплярах блоков.
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[S7] Комплексные блоки (мультиэкземплярные блоки)
Функции могут быть использованы совместно, с использованием различных
подфункций. Эти подфункции сами являются блоками и вместе вложены в
комплексный блок. Блок контроллера может, например, содержать блок
сообщений и блок управления работой (мультиэкземплярный блок).

Используя CFC, Вы можете создать эти блоки путем соединения различных
блоков (функций) и назначив соответствующие параметры в схеме. Затем Вы
компилируете схему как тип блока (см. Раздел 3.9.2).

Блоки с переменным числом входов блока
В CFC есть блоки, в которых количество входов переменно и может быть
изменено в схеме CFC (порождающий блок). Блок с переменным числом
входов, например, блок AND.

Семейства блоков
Блоки, сгруппированные вместе согласно их функциональным свойствам,
являются семейством блоков. Когда оно создается, каждый блок получает
серийный идентификатор. Следующие блоки, например, собраны в
семейства:

− блоки преобразования для согласования различных типов данных
CONVERT  (BO_BY, BY_DW, W_DW, ... т.д.).

− мультиплексные блоки
MULTIPLX (MUX8_R, MUXn_DI, ... т.д.)

− блоки с математическими функциями (плавающая точка)
MATH_FP (SQRT, ADD_R, ... т.д.)

Название семейства блоков используется, кроме прочего, как критерий для
сортировки блоков в каталоге CFC.

[S7] Организационные блоки
Интерфейс между операционной системой CPU и пользовательской
программой  - задачи, известные в S7 как организационные блоки (OB). С
использованием OB, специфические части программы могут выполняться  в
определенное время и в определенных ситуациях. OB для CPU выполняет
запуск (холодная, горячая перезагрузка), используется для аппаратных и
циклических прерываний (с разными временными базами) и т.д.

Организационные блоки или задачи не являются блоками в наглядном
представлении CFC; они не могут быть ни вставленными, ни
отредактированы в CFC. После вызова редактора последовательности
выполнения, блоки, помещенные в схему CFC, отображаются в OB в порядке
их обработки.
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Дальнейшие особенности
Блоки различаются также по типу. При создании блоков необходимо
объявить их как функциональный блок (FB), функцию (FC) или базисный
оператор (BOP).

• FB - блок с памятью, другими словами, данные блока существуют и
являются доступными при обработке от цикла к циклу. Для того, чтобы
сделать данные доступными, для каждого экземпляра блока создается
блок данных (DB). В комплексных блоках, возможно использование
дополнительных вложенных FB, для которых создается только один
общий DB.

• FC  - это блок без памяти; другими словами, величины, генерируемые
блоком, обрабатываются немедленно. Здесь не требуется блок данных.
FC не имеет назначенных по умолчанию величин на выходах.

• BOP также блок без памяти(подобно FC). Основные операторы - это
программные компоненты в CFC, которые вводятся в процессе
компиляции в текст SCL как операторы и используются для простых
функций, таких как AND, OR и т.д.

Особый случай: перекрывающиеся блоки
Перекрывающиеся блоки возникают при вставке или перемещении схем при
недостатке свободной площади не листе. В этом случае, они перекрываются
другими объектами полностью или частично.
Перекрывающиеся блоки выделены серым, у них не отображаются входы и
выходы до тех пор, пока они не будут перемещены на листе в свободную
позицию. Существующие соединения и вводы в панель листа
перекрывающихся блоков также невидимы, но, не смотря на это, существуют.
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1.5 Каталог

Каталог блоков, схем и библиотек
Блоки и схемы, которые Вы хотите вставить в схему CFC (используя
перетаскивание), можно взять из каталога.
Каталог состоит из окон, в которых показаны существующие семейства
блоков, библиотеки и т.д. (структура дерева). Диапазон отображения зависит
от PLC и установленных библиотек.
Вы можете переключаться от окна к окну, используя кнопки в нижней части
окна:

Блоки: Здесь Вы найдете существующие (импортированные) блоки и BOP,
расположенные в алфавитном порядке в разделе “All Blocks” ("Все блоки")
и согласно семействам и блокам текущей программы S7, которые Вы
можете вставить в схему.
Библиотеки: Здесь Вы найдете библиотеки блоков, из которых Вы можете
вставить новые блоки в схему. Показаны библиотеки, известные в SIMATIC
Manager.
Схемы: Здесь, Вы найдете схемы CFC текущей программы S7, которые Вы
можете вставить (копировать) или открыть.

Неразмещенные блоки: Здесь Вы найдете блоки текущей программы,
которые более не используются в схеме CFC. Схемы CFC, для которой
назначены эти блоки, также показана здесь. Каталог показан только тогда,
когда неразмещенные блоки существуют.
В нижней части каталога Вы можете найти следующие кнопки:

Найти блок или схему: Вы можете определить имя схемы или блока в
окне и найти их с помощью кнопки “Find" («Найти»). Папка (например, для
семейства блока), в которой находится этот объект, будет открыта. Вам
только необходимо задать первые несколько букв. Поиск остановится,
когда искомый объект будет найден. В течение поиска отображается
диалоговое окно с меню поиска. Здесь Вы также можете остановить поиск,
если он слишком затянулся.
Закрыть папки: Ниже кнопки “Find" («Найти») есть кнопка “Close"
(Закрыть). С помощью этой кнопки можно закрыть все открытые папки в
каталоге.
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1.6 [S7] Управление и мониторинг оператором

В процессе работы на AS генерируются сообщения, которые необходимо
передать системе управления и мониторинга оператором (PCS 7).
Используя конфигурирование сообщений в CFC, Вы можете непосредственно
в блоке создать сообщения о событиях, их текст и атрибуты.
Пока конфигурируется AS, Вы создаете данные, которые требуются OS для
коммуникации между AS и OS; другими словами, для управления и
мониторинга оператором. Вы можете передавать эти данные к OS в SIMATIC
Manager.

Блоки с сообщениями
Когда Вы вставляете блок  с сообщением в схему CFC, сообщение создается
автоматически. Этот блок имеет структуру сообщения с атрибутами и тексты
сообщений; другими словами, PLC посылает сообщение, когда происходит
событие без любой дополнительной конфигурации пользователем. Сигналы,
формирующие сообщения, могут также иметь связанные величины, что
позволяет вводить в текстовые сообщения переменные величины.
Вы можете редактировать атрибуты (такие, как класс или сообщения) и
тексты сообщения для отдельных экземпляров блоков с возможностями
конфигурации сообщений (Special Object Properties: “Messages"
(Специальные Свойства Объекта: “Сообщения")). Если кнопка ”Messages”
(«Сообщения») не активирована, блок не способен посылать сообщения.

Блоки,  управляемые  оператором
Все блоки сообщений для PCS 7 имеют атрибут для управления и
мониторинга оператором (S7_m_c). Для блоков, которые допускают ввод
оператором, можно выбирать и редактировать тексты. Вы можете запустить
диалог с помощью кнопки “Operator control and monitoring" (“Управление и
мониторинг оператором...") в свойствах блока (Object Properties). Атрибут
“Operator control and monitoring" (“Управление и мониторинг оператором")
блока CFC (экземпляра) также может изменяться. Для изменения этих
свойств, выберите или отмените “Operator control and monitoring"
(“Управление и мониторинга оператором") в свойствах объекта блока.

Соединение AS-OS
Когда Вы закончили конфигурацию сообщений, данные, требуемые OS для
соединения между AS и OS, передаются на OS (компиляция OS). Эти данные
передаются к одной или более целевым станциям и используются на этих
станциях графическими объектами или панелями управления . Для этой
передачи должен быть установлен программный пакет “AS-OS Engineering".
Для более подробной информации о передаче данных смотрите
интерактивную справку.
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1.7 Шаги конфигурации

Порядок шагов
1. Создайте структуру проекта
2. Создайте блоки и импортируйте их в CFC (необязательно)
3. Вставьте блоки в схему
4. Установите параметры для блоков и соедините их
5. Настройте рабочие свойства
6. Откомпилируйте схемы CFC
7. Загрузите программу CFC
8. Протестируйте программу CFC

Создание структуры проекта
Для работы с CFC Вы должны, используя SIMATIC Manager, в папке
программы создать папку схем (папка для системной программы).
Вы создаете отдельные схемы CFC в папке схем или используя SIMATIC
Manager или непосредственно в редакторе CFC.
[S7] Когда Вы создаете структуру проекта, Вас поддерживает помощник “New
Project" («Новый проект») (в зависимости от установок или для STEP 7 или
для PCS 7). Помощник PCS 7 создает мультипроект в обзоре компонент
(component view) и технологическом представлении (plant view). По
умолчанию, помощник PCS 7 также создает схему CFC.

Создание блоков (необязательно)
CFC работает с готовыми блоками. Это могут быть блоки из библиотек,
других программ или типов, которые Вы создали сами. Вы найдете
информацию о создании блоков в Разделе 3.9.2, "Компиляция как тип блока ",
и в руководстве "PCS 7 Programming Instructions Blocks" («Программирование
алгоритмических блоков»).

Импорт блоков
Способ, которым подключаются типы блоков и, в некоторых случаях,
импортируются, зависит от PLC.
Для более подробной информации смотрите Раздел 3.3.1.

Вставка блоков в схему
Блоки вставляются в схему перетаскиванием их из каталога. Создается
экземпляр блока с именем, которое в схеме уникально. Вы можете создать
любое количество экземпляров блока каждого типа.
Для более подробной информации смотрите Раздел 3.3.4.



Суть CFC

CFC для S7
A5E00177297-01 1-12

Установка параметров и соединение блоков
Вы можете назначить параметры входам и выходам блоков или Вы можете
соединить их или с другими блоками или с глобальными адресами.
(Глобальные адреса – это соединение партнеров вне схемы CFC, например,
в S7: периферийные сигналы входов и выходов, меркеры, таймеры, счетчики
и глобальные блоки данных.)
Вы можете определить текстовые соединения на входе блока /схемы, целе-
вое назначение которого еще не находится в папке схем. Это соединение
остается открытым пока существует ссылка на партнера по соединению,
затем соединение может быть замкнуто с использованием команды меню.
Соединение означает, что величины передаются от одного выхода к одному
или более входов в течение коммуникации между блоками или другими
объектами.
Для более подробной информации смотрите Раздел 3.5.

Настройка рабочих свойств
Рабочие свойства блока определяют, как блок будет включен в
последовательность выполнения структуры PLC. Эти свойства обязательны
для поведения PLC в смысле времени реакции, времени запаздывания или
устойчивости структуры, зависимой от времени, например, системы с
обратной связью.
Когда вставляется блок, каждому блоку назначаются свойства по умолчанию.
Блок устанавливается в определенную Вами позицию задания. При
необходимости Вы можете позже изменить установленную позицию и другие
атрибуты.
Для более подробной информации смотрите Раздел 3.7.

Компиляция схемы CFC
В процессе компиляции как программы, все схемы активного CPU
конвертируются в машинный код. В зависимости от целевого PLC
используются разные компиляторы; но их вызов, однако, идентичен. Если Вы
компилируете как тип блока, компилируется только отдельная схема.
Для более подробной информации смотрите Раздел 3.9.

Загрузка программы CFC
После компиляции Вы можете загрузить программу CFC в CPU.
Изменения в программе также могут загружаться в интерактивном режиме
без остановки CPU.
Для более подробной информации смотрите Раздел 3.10.

Тестирование программы CFC
После компиляции и загрузки программы Вы можете протестировать ее.
Диапазон и тип функций тестирования отличается в зависимости от типа PLC.
В режиме тестирования Вы интерактивно подключаетесь к PLC.
Для более подробной информации смотрите Раздел 4.3.
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2 Первые шаги

Введение
Эта глава “Первые шаги" построена как пример для новичков в CFC, которые
хотят быстро получить знания о пакете. Пример разделен на две разные
задачи и описан шаг за шагом от простейшего проекта до создания схемы со
входами и выходами и блоков в CFC.

Замечание:
Вы найдете готовый пример в SIMATIC Manager:
File > Open... > “Sample projects" раздел > ZDt04_01_CFC (Немецкий).
(Английский: ZEn..., Французский: ZFr..., Испанский: ZEs..., Итальянский:
ZIt...)

В этом примере предполагается, что CFC будет использоваться в среде
STEP 7. Это значит, что установлен стандартный пакет STEP 7, SCL и CFC. В
качестве PLC используется или S7-300 или S7-400.
Вы можете создать простой проект “CFCEXA_2", описанный ниже, с помощью
SIMATIC Manager.
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2.1 Создание управления  с замкнутым циклом с
имитатором процесса

2.1.1 Создание проекта

В этом разделе описаны шаги, включая создание проекта с помощью команд
меню SIMATIC Manager. Вы конфигурируете аппаратное обеспечение в HW
Config (это можно сделать позднее, но обязательно перед загрузкой в CPU).
Этот пример создан в программе S7:

• В панели инструментов нажмите  или выберите команду меню File >
New... (Файл>Новый).
В диалоговом окне “New Project" («Новый проект») введите имя проекта
“CFCEXA_2" и нажмите “OK".

• С выделенной папкой проекта, подайте команду меню Insert > Program >
S7 Program (Вставка > Программа > Программа S7).
В "Component View"  ("Обзоре компонент") создается программа S7 с
папкой исходных файлов, папкой блоков и таблицей символов.

• С выделенной папкой программы S7, подайте команду меню Insert > S7
Software > Chart Folder (Вставка > Программа S7 > Папка схем).
Создается папка схем.

• С выбранной папкой, подайте команду меню Insert > S7 Software > CFC
(Вставка> Программа S7 > CFC).
Создается схема "CFC(1)"; дайте ей имя "Control".

• Дважды щелкните на схеме CFC для того, чтобы открыть ее.
Все требующееся для работы с редактором CFC выполнено.
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2.1.2 Создание схемы

Цель
Сейчас Вы создадите схему управления с имитатором, в котором процесс
имитируется скользящей средней величиной. Вы используете для этого два
блока: SAMP_AVE и CONT_C. Блок SAMP_AVE формирует среднюю
величину из некоторого числа входных величин, а CONT_C  - это контроллер
PID, который управляет этой переменной средней величиной.

SAMP_AVE 
Sliding averag

Process 

R  IN 
I   N 

   OUT   R 
30 

OB35 
2/- 

OB35
1/-

CONT_C
Continuous PID

Contr

R   SP_INT

R   PV_IN

R   MAN

R   GAIN

TI   TN
TI   TV

  LMN   R

0.0

20.0

20s

10s

2.0

0

Среднее значение формируется из 30 
последних  значений заданных на выходе 
LMN блока Contr  и передается с выхода 
OUT блока Process на вход PV_IN блока 
Contr 

Блок Process имитирует процесс 

Блок Сontr управляет переменной

BO_MAN_ON

R   DEADB_W

LMN передает 
управляющую величину 
на вход  IN блока Process

Вставка блоков

• Откройте каталог  , если он еще не открыт (по умолчанию).

• В каталоге нажмите кнопку библиотеки  . Здесь Вы можете открыть
Библиотеку CFC. Это коллекция библиотек блоков.

• Теперь откройте папку ELEM_300. Это библиотека с блоками,
пригодными для CPU типов S7-3xx. Если Вы используете CPU S7-4xx,
откройте папку ELEM_400.
Вы можете перетащить в схему блоки из открывшегося списка.

• Нажмите CONT_C, удерживая кнопку мыши, перетащите блок в схему.
Расположите его в верхнем правом углу на листе 1.

• Затем возьмите блок SAMP_AVE и расположите его слева от блока
CONT_C.

• Дважды щелкните по свободной позиции для того, чтобы переключиться к

просмотру листа (или нажмите в панели инструментов ).
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При просмотре листа Вы видите блоки, как графические объекты с
заголовком, и несколькими входами и выходами в теле блока. Входы и
выходы (входы слева, выходы справа) показаны как поля с именем и
типом данных, последний виден для "wide" ("широкого") отображения. С
помощью Options > Customize > Block/Sheet Bar Width...... (Опции >
Настройки > Ширина блока и панели листа…), Вы можете установить
ширину блока "Narrow" ("Узкий") или "Wide" ("Широкий"). Если установлен
"Узкий" (по умолчанию), блоки будут показаны узкими и без типа данных.

Соединение блоков
Для соединения блоков выполните следующее:
• Щелкните на выходе OUT блока SAMP_AVE и затем щелкните на входе

PV_IN блока CONT_C.
• На блоке CONT_C щелкните на выходе LMN, а затем щелкните на входе

IN блока SAMP_AVE.
Другим способом, Вы можете, используя мышь, перетащить выход блока
на вход того блока, с которым хотите установить соединение.

Теперь два блока соединены.

Изменения видимости блоков
Блоки показаны в схеме со всеми входами и выходами так, как предписано
типом блока. В нашем примере, однако, нам не требуются все входы и
выходы и для того, чтобы сделать экран проще и чище, мы можем некоторые
ненужные входы и выходы сделать невидимыми. В том же диалоге мы можем
поменять имя блока.
• Дважды нажмите на заголовок блока CONT_C: откроется диалоговое окно

"Properties" ("Свойства"). Имя ("1") уже выбрано, и Вы можете сразу же
напечатать новое имя "Contr".

• Теперь выберите страницу "Inputs/Outputs" («Входы/выходы»). Используя
горизонтальную линейку прокрутки, перемещайтесь вправо до появления
колонки "Not displayed" («Не показывать»).

• Нажмите первую выбранную ячейку, удерживайте кнопку мыши и тащите
курсор вертикально до конца колонки: выбрана вся колонка. При
положении курсора в выбранной области нажмите правую кнопку мыши и
выберите команду меню "Set" («Установить»).

Все несоединенные входы и выходы получат свойство “Not displayed" (“Не
показывать"). Но некоторые входы и выходы будут нужны позднее в режиме
тестирования входных величин. Мы можем сделать их снова видимыми.
• В колонке “Not displayed" ("Не показывать"), щелкните в боксах:

MAN_ON
SP_INT
MAN
GAIN
TN
TV
DEADB_W.
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Установка параметров входов и выходов и выбор их для тестирования
• В таблице "Inputs/Outputs" («Входы/Выходы»), выберите колонку

"Watched" («Наблюдаемый») и установите все входы и выходы
наблюдаемыми, включая соединенный выход LMN.

• В колонке "Value" (Величина), введите "20" для SP_INT
(по умолчанию для контроллера).
Закройте Свойства объекта, нажав "OK".

Также Вы можете непосредственно установить параметры для отдельных
входов и выходов:
• Дважды нажмите на вход MAN_ON контроллера.
• В окне "Value" («Величина») измените "1" на "0".

Это приведет к отключению "Manual Mode" («Ручного режима»), который
размыкает обратную связь.

• Закройте диалоговое окно, нажав "OK".
Выполните то же с блоком SAMP_AVE (используйте диалог свойств для
отдельных входов и выходов или диалог свойств блока, как описано ниже).
• Дважды нажмите на заголовок блока SAMP_AVE. Дайте этому блоку имя

“Process".
• В таблице "Inputs/Outputs" («Входы/Выходы») установите для входа N в

свойство "Watched" («Наблюдаемый») (если еще не установили).
• В колонке "Value" («Величина») введите для N значение "30".

(это число величин входов используется для средней величины.)
• Закройте диалоговое окно, нажав "OK".
Сейчас блоки соединены и имеют необходимые параметры для нашей
имитации процесса.
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2.1.3 Компиляция и загрузка схемы

Следующие шаги компилируют схему как программу.

• Выберите на панели CFC  кнопку   или команду Chart > Compile >
Charts as Program.... (Схемы > Компилировать > Схемы как
программа...).
В появившемся диалоговом окне установите "Compile: Entire program"
(«Компилировать: Программа в целом»). Нажмите "OK". Начнется
компиляция и процесс отобразится в диалоговом окне. Согласитесь с
итоговым сообщением S7 с помощью "Close" (Вы можете игнорировать
предупреждения).

Замечание:
Следующие шаги возможны, только если Вы подключились к CPU типа S7-
3xx или S7-4xx. Переключатель CPU должен быть в режиме: RUN-P.

• Для загрузки программы в CPU, выберите кнопку 
или PLC > Download...( PLC > Загрузить...).
В диалоговом окне выберите тип загрузки (всегда установлен: "Entire
program" («Программа в целом»)).

Перед загрузкой программы CPU устанавливается в режим STOP (после
запроса и ответа "Yes") и любые блоки в памяти CPU удаляются. Загрузка
отображается в диалоговом окне. После удачной загрузки программы (без
ошибок), появится сообщение, что загрузка выполнена, и запрос, хотите ли
Вы перезапустить CPU. Если Вы ответите "Yes", Вы вернете CPU в режим
"RUN".
CPU в режиме RUN. Программа загружена, теперь ее необходимо
тестировать.
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2.2 Тестирование программы

В режиме тестирования Вы можете контролировать входные и выходные
величины блока и изменять входные величины блока. Величины,
зарегистрированные для тестирования, показаны на желтом фоне.
Если Вы изменили некоторые из параметров, то можете наблюдать реакцию
контроллера, например, как управляемая величина достигает заданное
значение.

Изменение режима тестирования
Прежде чем переключиться в тестовый режим, измените режим из "Process
Mode" («Рабочий режим») в "Laboratory Mode"(«Лабораторный режим») ("Test
> Laboratory Mode"). Это значит, что все входы и выходы блока автоматически
активируются для "Watching" («Наблюдения»).
Замечание: В "Process Mode" («Рабочий режим»), входы и выходы по
умолчанию не установлены для наблюдения. В этом режиме для
тестирования Вы можете выбрать нужные блоки и зарегистрировать их для

просмотра (нажав ).

Активирование режима тестирования:

• Нажмите  или выберите Debug > Test Mode (Отладка > Тестовый
режим).

Изменяющиеся величины в интерактивном режиме
Вы можете, например, задать различные установочные значения, таким
образом:
• На контроллере, дважды щелкните на вход SP_INT и установите в

диалоговом окне другую величину (< 100) как внутреннюю заданную
точку.

• Нажмите  "Apply" (Применить) для подтверждения величины, диалоговое
окно останется открытым для других изменений.

После того, как Вы сделаете несколько изменений и проверите реакцию на
них, нажмите "OK".
Вы можете, например, повлиять на скорость установки на входах блока:

− GAIN (коэффициент пропорционального управления)

− TN (время сброса, определяет интегральный компонент)

− TV (время, определяющее дифференциальный компонент)
Если Вы изменили “GAIN" на более низкую величину и  увеличили время
“TN", динамический отклик контроллера изменится и отклик будет более
“вялым".
С помощью входа блока MAN_ON, Вы можете разорвать цикл управления и
включить ручное управление (=1). Управляющая величина (величина на
выходе LMN) установится в значение, заданное на входе MAN.
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Результат
В этой части примера Вы получили знания об элементарных аспектах
конфигурации CFC. Вы можете создать проект с помощью SIMATIC Manager,
создать схему CFC и вставить блок из библиотеки. Вы соединяете блоки и
устанавливаете параметры. Вы можете создавать работающую программу и
загружать ее в CPU. В режиме тестирования, Вы управляете и изменяете
динамический отклик управления с обратной связью.
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2.3 Изменения в схеме

Мы сейчас находимся в режиме тестирования.

• Выберите режим редактирования, отжав кнопку .

2.3.1 Изменение свойств исполнения

Введение
Блоки схемы имеют свойства выполнения в определенной
последовательности во времени. Эти рабочие свойства определяют, когда и
в каком порядке блоки выполняются в CPU. Чтобы организовать
последовательность выполнения, блоки включаются в OB.
В данном примере, блоки по умолчанию устанавливаются в OB35 (цикличес-
кое прерывание с интервалом 100 мс) и, поскольку они также включены в
задачу перезапуска, они устанавливаются в OB100 (теплый перезапуск).
Таким образом, Вам не нужно беспокоится о включении в рабочую последо-
вательность для каждого блока, CFC установит блоки один за другим после
одного, особенного блока. Этот блок определен для блоков, установленных
позднее, как "Predecessor for Installation" ("Предшественник для установки"). В
строке состояния CFC (справа внизу окна), Вы можете посмотреть, какой блок
является "Предшественником для установки".
Когда Вы создаете схему CFC, рабочая группа создается автоматически и
имеет такое же название, как и схема.
Вы можете назначать рабочей группе атрибуты, которые задают отношение
циклов выполнения и смещение по фазе циклов OB, в которых выполняются
блоки.

Изменение свойств выполнения
Вы хотите, чтобы блоки выполнялись в различной последовательности.
Режим тестирования деактивирован, и Вы вызываете редактор
последовательности выполнения.

• Нажмите кнопку на панели инструментов   или выберите Edit > Run
Sequence...( Редактор > Последовательность выполнения..).

Открывшееся окно покажет все OB. Объекты уже установлены в OB100 и
OB35, как можно видеть, нажав в окне + перед иконкой OB.

• Выберите OB35 и рабочую группу "Ctrl", содержащуюся в нем. Блоки
будут показаны справа.

Помните: Рабочая группа создается автоматически при создании схемы.

• Держите курсор на рабочей группе и выберите команду меню Object
Properties...(Свойства объекта) с помощью правой кнопки мыши.
Появится диалоговое окно.
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• В диалоговом окне выполните следующие установки:

Name (Имя) Ctrl (по умолчанию сохраняется)
Comment (Комментарий) U8_PV0
Scan rate (Отношение циклов) 8
Phase offset (Смещение по фазе) 0 (по умолчанию сохраняется)
Optimizing the Run Sequence
(Оптимизация  последова-
тельности выполнения)

√ (по умолчанию сохраняется)

Active (Активный) √ (по умолчанию сохраняется)

• Подтвердите установки "OK".
С теми установками, которые Вы сделали для отношения циклов, блоки
выполняются каждый восьмой цикл; другими словами, с базовым временем
цикла OB35, равным  100 мс они будут выполняться каждые 800 мс.
Смещение по фазе может использоваться для достижения лучшего
распределения загрузки CPU, когда у Вас имеются блоки в нескольких
рабочих группах. Это не соответствует нашему примеру, значение по
умолчанию "0", другими словами, смещения периода нет.
Опция "Optimize Run Sequence" (Оптимизация последовательности
выполнения) определяет, включена или нет рабочая группа в процесс
оптимизации, что должно быть указано явно(см. Раздел 3.7.4). С "активной"
опцией, рабочая группа активируется или деактивируется для работы на
CPU.

Копирование блоков внутри схемы
В качестве практического примера Вы скопируете содержимое листа 1 в лист
2 и отредактируете его. Когда Вы копируете соединенные блоки, соединение
сохраняется.
• Переключитесь с редактирования последовательности выполнения на

редактирование схемы.
Чтобы сделать это, щелкните в любой точке окна схемы

(CFCEXA_2\S7 Program(1)\...\\ Control) или снова нажмите  и

измените обзор нажатием .
• На листе 1, удерживая нажатой левую кнопку мыши нарисуйте петлю

вокруг соединенных блоков. Блоки будут выделены (синим).
• Сохраняя курсор мыши на выделении, удерживайте нажатой клавишу Ctrl

и перетащите блоки на лист 2 (ниже листа 1).
• Выберите блок "Contr1", скопируйте его и вставьте снова на тот же лист.

Блок называется "Contr2".
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Изменение соединения
• Нажмите на линию соединения или на выход LMN в "Contr1" и нажмите

клавишу "Del". Соединение с входом IN  "Process1" будет удалено.
• Нажмите на LMN в "Contr1" и затем на SP_INT в "Contr2".

(Позже, Вы узнаете более элегантный метод "перемонтажа" без удаления
и соединения заново).

• Нажмите на LMN в "Contr2" и затем на IN в "Process1".
• Нажмите на OUT в "Process1" и затем на PV_IN в "Contr2".
При размещении блоков, как показано ниже, соединение установится
следующим образом:

Ветвление

OB 35 
1/3 

CONT_C
Continuous PID

Contr1

  
LMN  R 

0.0

20.0

20s

10s

2.0

0

R  SP_INT

R  PV_IN

R  MAN

R  GAIN

TI TN

TI TV

BO MAN_ON

R  DEADB_W0.0

SAMP_AVE 
Sliding averag 

Process 

R  IN

I  N 
   OUT  R

OB 35
1/4

30 

OB 35 
1/5 

CONT_C
Continuous PID

Contr2

  LMN  R 

0.0

20s

10s

2.0

0

0.0

R  SP_INT

R  PV_IN

R  MAN

R  GAIN

TI TN

TI TV

BO MAN_ON

R  DEADB_W
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Компиляция, загрузка и тестирование изменений
Схема должна быть откомпилирована заново и затем загружена в CPU.

• Выберите кнопку  на панели инструментов.
В диалоговом окне установите опцию "Compile: Changes only"
(«Компиляция: только изменений») и нажмите "OK". Компиляция
началась, согласитесь с сообщением, нажав  "Close".

• Для загрузки программы выберите кнопку .
В диалоговом окне установите "Download: Changes only" («Загрузка:
только изменений») и нажмите "OK".

Когда Вы загружаете изменения (как альтернатива вводу программы), не
нужно переводить CPU в режим STOP.
Внимание! Если Вы работаете с реальным проектом, убедитесь, что Вы в
курсе информации "Reasons for STOP when Downloading Changes Online"
("Причины для STOP при интерактивной загрузке изменений") в
интерактивной справке.

(Help > Contents, страница "Index": Напечатайте "Reasons for"  и нажмите
кнопку "Display".)

После загрузки Вы можете вернуться в режим тестирования и протестировать
измененную программу.

Результат
В этой части Вы узнали, что блоки в схеме CFC имеют определенные
свойства выполнения на CPU и Вы можете изменять эти свойства. Также Вы
увидели, что подструктура, известная как рабочая группа, используется в
последовательности выполнения, ее атрибуты Вы можете назначать сами.
Вы можете копировать блоки внутри схемы и видите, что соединение между
блоками сохраняется. Вы изменяли соединения и снова создавали
работающую программу. Вы увидели различия между загрузкой программы в
целом и загрузкой только изменений.
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2.4 Создание входов и выходов схемы и схема-в-схеме

В следующем разделе Вы будете создавать входы и выходы схемы CFC и
вставлять эту схему в другие схемы CFC.

2.4.1 Создание схемы с входами и выходами

Схема с входами и выходами может быть использована для "модульных"
схем CFC для дальнейшего использования. Когда Вы создаете схему с
входами и выходами, Вы можете определить, какие входы и выходы блока
следует соединить с другими схемами или блоками и должны быть
добавлены к входам и выходам схемы.

Подготовка

• Создайте новую схему, нажав на панели инструментов . В
диалоговом окне введите имя объекта: "Sim_reg" и нажмите "OK".
Появится новая схема.

• При нажатии на панели инструментов , схема "Sim_reg" и схема
"Control" появятся одна перед другой.

• Установите обзор экрана для обоих схем с помощью .
• Скопируйте блоки листа 1 схемы "Control" в лист 1 схемы "Sim_reg" таким

же образом, как Вы делали это при копировании блоков внутри схемы.
• Закройте схему "Control" и переключитесь к просмотру листа (лист 1)

схемы "Sim_reg".

• Откройте в каталоге раздел блоков, нажав кнопку  и затем
семейство блоков MULTIPLX.

• Протащите блок SEL_R на лист 1 и дайте ему имя "Switch" (в диалоге
свойств).

Для того, чтобы включить блок "Switch" в наш пример, Вы должны сейчас
"перемонтировать" существующее соединение; другими словами, Вы
изменяете соединение без удаления существующего.
• На блоке "Contr", выберите вход PV_IN и, удерживая кнопку мыши,

перетащите его к входу IN1 в "Switch". Выход OUT блока "Process" теперь
соединен с входом IN1 блока "Switch".

Как вариант, Вы можете удалить существующее соединение и создать новое.
Выход "Switch" должен сейчас быть соединен с входом для переменной
процесса "Contr".
• Соедините выход OUT блока "Switch" с входом PV_IN блока "Contr".
Теперь "Switch", в зависимости от величины на входе K, переключает
величины с входов IN0 (K=1) или IN1 (K=0) на выход OUT.
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В реальном проекте, это позволяет Вам переключаться между симулятором
процесса (IN1) и реальным процессом (величина с входа, соединенного с
IN0).

Создание входов и выходов схемы
Сейчас Вы создадите входы и выходы для схемы. Затем они соединяются с
выбранными входами и выходами блоков.

• Нажмите кнопку  на панели инструментов или выберите View > Chart
I/O (Обзор> Входы и выходы схемы).
Откроется диалог для редактирования входов и выходов схемы и
"прикрепится" к открытой части окна схемы.

• В левой части окна нажмите иконку группы входов IN. Входы блока
показаны в правой части окна (пустая).

• В рабочей области схемы выберите вход блока MAN_ON на "Contr" и
перетащите вход в окно входов и выходов схемы на бокс "Name". Затем
вводится вход со всеми его свойствами.

• Проделайте эту процедуру со всеми не соединенными входами (см.
таблицу).

• Измените имя входа K блока "Switch" в входах и выходах схемы двойным
нажатием в окне "Name". Введите здесь SIM. Вместо IN0, введите PV
(величина процесса).

• В левом окне входов и выходов схемы  нажмите иконку группы выходов
OUT. Выберите выход LMN на "Contr", удерживая клавишу Ctrl,
перетащите выход в правую часть окна входов и выходов схемы на бокс
"Name".

Должны появится следующие входы и выходы схемы:

 Блок  Вход блока  Тип данных  Выход блока  Тип
данных

Contr MAN_ON BOOL LMN REAL
SP_INT REAL
MAN REAL
GAIN REAL
TN TIME
TV TIME
DEADB_W REAL

Switch SIM (previously: K) BOOL
PV (previously: IN0) REAL

Панель листа покажет имена входов и выходов и комментарии, тип входов и
выходов и тип данных, применяющихся к входам и выходам схемы.
Сейчас Вы создали все входы и выходы для схемы.
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Вы можете закрыть окно входов и выходов схемы, нажав  и можете
"убрать" схему, сделав ее более читаемой.
• Поместите блок в схему так, чтобы линии соединения пересекались как

можно меньше. Одно из возможных расположений показано ниже.

Contr

Switch

Process
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2.4.2 Вставка схемы в другую схему

Схема "Sim_reg", созданная в предыдущей конфигурации со входами и
выходами, вставляется в другую схему. Создайте новую схему:

• Нажмите кнопку  на панели инструментов. В диалоговом окне
введите в Object name (Имя объекта): "Top Chart" и нажмите "OK". Будет
показана новая схема.

• Откройте каталог "Charts" ("Схемы"), нажав кнопку .
В иерархии Вы увидите схемы "Top Chart", "Control" и "Sim_reg".
Замечание: Если каталог содержит только сообщение "! "! (no hierarchy
folder exists)" (иерархии не существует)", установите опцию "Display
catalog with plant hierarchy" («Показать каталог с технологической
иерархией») в  диалоговом окне Options > Customize > Display...
(Опции > Настройка > Показать...). Поскольку проект был создан без
иерархии, эта опция должна быть запрещена (нажмите в боксе выбора:
галочка удаляется).

• Выберите схему "Sim_reg" и перетащите ее в рабочую область "Top
Chart". Оригинальная схема скопирована.

• Переключитесь к просмотру листа.
Схема со входами и выходами похожа на блок и может быть изображается
как схема с иконкой:

Вы можете увидеть, что это копия предыдущей созданной схемы, откройте
ее выбором команды Open, используя меню, выпадающее по щелчку правой
кнопки мыши. В заголовке окна Вы видите, что это "вложенная схема" с
путем: ...\\Top Chart\Sim_reg.
В каталоге схемы, показан бокс + спереди от "Top Chart". Нажатием на + (или
двойным нажатием иконки схемы), Вы можете открыть дерево и увидеть
иерархию схемы: схема "Sim_reg" показана в виде ветви как активная схема
(иконка открытой папки).
Для того, чтобы вернуться к верхней схеме, Вы можете выбрать "Open Parent
Chart" («Открыть родительскую схему») с помощью правой кнопки мыши или
выберите путь для "Top Chart" в меню "Window".

Результат
В этой части Вы узнали, как редактировать схему с входами и выходами, что
позволяет соединять ее с другими с входами и выходами блоков и
использовать так часто, как требуется. Вы увидели, как схема может быть
вставлена подобно блоку (техника схема-в-схеме). Вы увидели, в отличие от
блока, вставленная схема может открываться и изменяться.
С помощью техники схема-в-схеме Вы можете создавать вложенные схемы и
создавать структуру с большей ясностью отражающей технологические
особенности.
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2.5 Создание типа блока

Обычно, папка схем, содержащая открытые схемы, компилируется в целом.
Это дает программу, которая затем загружается в CPU. Вы можете, однако,
также компилировать простую схему и создавать из нее тип блока. Затем он
помещается в библиотеку блоков или в программу S7 для дальнейшего
использования.

Компиляция схемы как типа блока
Сейчас Вы скомпилируете оригинальную схему "Sim_reg" как тип блока.
• Закройте все схемы (Window > Close All) (Окна> Закрыть все).
Убедитесь. Что Вы открыли оригинальную схему "Sim_reg", которая
находится на иерархическом уровне схем "Top Chart" и "Control".
• Выберите схему "Sim_reg" в каталоге "Схемы" и откройте ее, используя

правую кнопку мыши.

• Выберите Chart > Compile > Chart as Block (Схема > Компиляция >
Схема как блок).

Появится диалог, в котором Вы введете дальнейшую информацию.

• В окне "Свойства типа блока " введите:

FB number (Номер FB): 110
Symbolic name
(Символьное имя):

REG_1

Name (header)
(Заголовок):

REG_1

Family (Семейство): CONTROL
Author (Автор): TEST
Version (Header)
(Версия (заголовок)):

0.1

И нажмите "OK".

Начнется компиляция. После успешной компиляции, блок "FB110" находится
в папке блоков, а символьное имя "REG_1 введено в таблицу символов.
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2.5.1 Тестирование блока

Следующий шаг – это создание новой схемы и ввод в нее блока REG_1.
• Создайте новую схему "Test".
• Нажмите клавишу "F5" (или View > Update (Вид > Обновить)), чтобы CFC

читала изменения в таблице символов и папку блоков.
• Откройте программу S7 в каталоге блоков. Здесь, Вы увидите новый тип

блока REG_1.
• Вставьте REG_1  в схему "Test", перетащив ее мышью и переключитесь к

просмотру листа. Вы увидите входы и выходы блока, как и входы и
выходы схемы. Вход EN и выход ENO добавлены системой (для
активации и деактивации блоков). Эти вход и выход невидимы (по
умолчанию). Если Вы хотите отобразить эти вход и выход, Вы должны
сделать их видимыми в свойствах объекта, таблица "Входы/Выходы".

• Откомпилируйте схемы как программу все вместе и загрузите программу

в CPU. Нажмите  .

Вы получите сообщение, что программа была изменена и должна быть
откомпилирована.

• Ответьте на вопрос "Do you want to compile now and then download?"
("Хотите ли Вы откомпилировать сейчас и затем загрузить?")  - "Yes"
("Да").

Вы увидите диалоговое окно с страницами "Compile Charts as Program"
("Компилировать схему как программу") и "Download S7" ("Загрузка S7").

• Выберите "Scope: Changes" («Область: изменения») в обеих таблицах и
нажмите "OK".

• Затем переключитесь в режим тестирования  для просмотра и
измените входы и выходы блока.

С помощью входа SIM, Вы можете переключаться между внутренней
имитацией (= 0) и внешней величиной процесса (вход PV) (= 1).

Заключительные комментарии
В этом примере, Вы получили знания о некоторых возможностях CFC.
Упражнения проиллюстрировали, как легко Вы можете создать программу
для задачи автоматизации, которая затем может быть выполнена на CPU.
Теперь Вы можете  решать более сложные задачи.

Следующие главы и интерактивная справка CFC дадут Вам более подробную
информацию.
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3 Работа с Редактором CFC

Описание
В этой главе описано, как конфигурировать программную структуру для CPU,
используя редактор CFC.

Требования
Используя SIMATIC Manager, Вы создаете проект с папкой программы для
определенного устройства автоматизации (например, программа S7 для
SIMATIC S7), включающей папку схем.

Замечание:
CFC –  "совместим вверх", это означает, что программы, созданные в CFC,
можно изменить с помощью других инструментов без редактора CFC, но
после этого их редактирование в CFC невозможно.

Ограничения для множества пользователей в сети:
Несколько пользователей могут работать в одном проекте. Это позволяет
конфигурировать, тестировать и  запускать AS для выполнения в различных
точках или в сети PC (многопользовательский режим ).
Если PC включен в сеть, помните, что одно устройство автоматизации AS
может одновременно редактироваться только одним пользователем.
Если несколько человек в различных точках хотят работать в проекте, проект
можно разделить, отредактировать, затем снова соединить. Вы можете
распределить отдельные схемы программы S7 на несколько рабочих
проектов, затем, после редактирования, соединить их вместе.
Для более подробной информации обратитесь к Разделу 3.12, Раздельная
разработка проекта или интерактивной справке CFC.
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3.1. Обработка схем

Создание схемы
Обычно Вы создаете схему с помощью SIMATIC Manager (команда меню
"Insert > S7 Software > CFC" (“Вставка> Программы S7 > CFC)); но это
возможно и напрямую в редакторе CFC (команда меню "Chart > New" (“Схема
> Новая")). Имя схемы должно быть уникальным в пределах CPU
(проверяется системой) и не должно содержать более 22 символов.

Когда Вы создаете новую схему, автоматически создается рабочая группа
(run-time group) и устанавливается последовательность выполнения,
согласованная с установкой схемы. Имя рабочей группы совпадает с именем
схемы.

Открытие схемы
Вы можете открыть схему с помощью SIMATIC Manager. Выберите проект и
папку проекта, откройте папку схем и дважды щелкните на нужной схеме,
чтобы открыть ее, запустив, одновременно, редактор CFC.
Меню «Chart»("Схема") в редакторе CFC всегда показывает последние
четыре схемы, которые Вы редактировали и закрыли. Если Вы выбрали одну
из этих схем, откроется соответствующая схема или, если она уже открыта,
эта схема отобразится на экране.
Вы можете открыть схему, которая не показана в меню "Схема", выбрав
команду меню "Chart > Open" ("Схема > Открыть») и проект в диалоговом
окне, выбрав папку программы и тип объекта "CFC", и дважды щелкнув на
выбранной схеме.
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Копирование/перемещение схемы
Копирование целых схем позволяет Вам дублировать или перемещать
структуры или подструктуры, которые Вы хотите протестировать, даже в
другой CPU.
Когда Вы копируете/перемещаете схемы, ресурсы (типы блоков, FB и FC,
включая символы, системные атрибуты и вызываемые экземпляры
мультиэкземплярных блоков), также копируются, если они не существуют уже
в пункте назначения.
Помните, что на выполнение функции Копировать/Перемещать влияют
существующие соединения и блоки. Если тип блока в пункте назначения CPU
несовместим с типом блока, который Вы копируете (число, порядок, имя и тип
данных входов и выходов блока), схема не будет скопирована.
В таком случае, перед копированием:

− Вы должны скопировать соответствующий тип блока или папку блоков
исходной программы в папку блоков программы назначения.

− Выберите тип блока в окне "Chart Folder" ("Папка схем") с помощью
команды меню "Options > Block Types..." ("Опции > Типы блока...") и
измените общий тип блока кнопкой "New Version" ("Новая версия").

Скопированные блоки сохраняют свойства выполнения блоков исходного
CPU; другими словами, они установлены в последовательности выполнения
так же, как и в исходном CPU. Если задачи с таким именем не существует в
назначенном CPU, выводится сообщение о недостающей задаче и
копирование не выполняется.
Если Вы копируете/перемещаете схему в другую папку схем, соединение с
другой схемой становится текстовым. Открытое текстовое соединение
может быть замкнуто снова (с реальным соединением блоков), если схема с
партнером по соединению также копируется или перемещается в папку схем
или если схема копируется/перемещается обратно в исходную папку.
Если текстовое соединение уже существует в схеме и схема
копируется/перемещается, текстовое соединение берется вместе со схемой
Для более подробной информации смотрите Раздел 3.6.3.
Когда копируется схема, помните, что соединения с глобальными адресами
копируются в зависимости от настроек по умолчанию.  Вы можете установить
их в диалоговом окне “Settings for Copying/Moving" ("Установки для
копирования /перемещения") (команда меню "Options > Customize >
Copy/Move..."("Опции> Настройка > Копировать/ Переместить...")).
Схемы CFC могут также копироваться /перемещаться между различными
целевыми системами (например,  SIMATIC S7 ↔ SIMATIC M7). В этом случае
типы блоков, используемые обеими системами, должны быть идентичными;
другими словами, они должны быть совместимы, иначе они не копируются.

Закрытие/Удаление схем
Поскольку все изменения в схеме сохраняются немедленно, Вы можете
закрыть схему или выйти из редактора в любое время.
Удалить схему CFC Вы можете в SIMATIC Manager.
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3.2. Создание схемы

В начальном виде (после вставки в папку схем), схема CFC состоит из одного
раздела схемы с 6 листами. Вы можете переименовать такую схему и
расширить ее.
Вы можете добавить в схему входы и выходы (см. Раздел 3.2.3) так, что она
будет соединена с другими схемами или вставлена в другую схему, где может
соединяться с другими блоками. Если Вы используете технику схема-в-схеме
(вставка схем с входами и выходами в другую схему), Вы создаете
вложенные схемы (см. Раздел 3.2.4).
Схема может быть вставлена в другую схему и без входов и выходов
(например, если Вы хотите создать входы и выходы позже).

3.2.1 Настройка свойств схемы

В диалоговом окне "Properties CFC Chart" (“Свойства схемы CFC”), Вы можете
установить параметры активной схемы, такие как, имя схемы, автор и
комментарии.
В CFC, Вы можете отобразить диалоговое окно с помощью команды меню
“Chart > Properties…” (“Схема > Свойства…”).
Для полной информации и информации о назначении имен в PCS 7, смотрите
интерактивную справку CFC.

3.2.2 Вставка и удаление разделов схемы

При необходимости Вы в любое время можете добавить в схему CFC
дополнительные разделы. Для каждого раздела схемы есть закладка, с
помощью которой Вы находите нужный раздел в нижнем краю окна на высоте
линейки прокрутки.
Когда Вы вставляете раздел схемы, Вы можете решать, вставить ли новый
раздел перед текущим или добавить как последний раздел. Схема может
состоять из 26 разделов; они обозначаются буквами алфавита (A - Z).
Алфавитный идентификатор отдельных разделов схемы может меняться,
если Вы вставляете дополнительные разделы.
Например, схема "CFC1" состоит из одного раздела, ему дана буква "A". Если
Вы вставляете дополнительные разделы перед первым, новая часть станет
"A", а предыдущая  - "B".

 

Раздел схемы A

Раздел схемы C
Раздел схемы B

Раздел схемы D

Схема"CFC1"

Рисунок3-1:Схема с разделами
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В зависимости от вида (просмотр листа или обзор схемы), идентификатор
текущего раздела схемы показан в строке состояния вместе с номером листа
или со словом "Overview" ("Обзор"). Пример:

 Просмотр листа Обзор схемы:
B/Sheet 3 B/Overview 

Вы можете только удалить активный раздел схемы. Если активный раздел
пуст, Вы удалите его после того, как выберите команду меню "Edit > Delete
Chart Partition" ("Редактор > Удалить раздел схемы"). Если раздел схемы
содержит объекты, Вы будете должны подтвердить удаление.

3.2.3 Создание схемы с входами и выходами

Вы можете создать схему с входами и выходами для расширения
возможностей, таких как

• Установка в различные схемы (вложенные схемы, см. Раздел 3.2.4) и
соединение с другими схемами или блоками

• Компиляция в качестве типа блока
Вы назначаете выбранные входы и выходы внутренних блоков,
содержащихся в схеме, или вложенных схем входам и выходам схемы.

Окно "Chart Inputs/Outputs" (" Входы и выходы схемы ")
Вы создаете входы и выходы схемы в отдельном окне CFC.
С помощью команды меню "View > Chart Inputs/Outputs" ("Вид > Входы и

выходы схемы") или кнопки  на панели инструментов, Вы можете открыть
(и закрыть) окно "Chart Inputs/Outputs" ("Входы и выходы схемы").
Процедура для создания входов и выходов схемы подробно описана в
примере в Разделе 2.4.1.

Системные атрибуты
Как и в блоках, Вы можете назначать системные атрибуты для отдельных
входов и выходов схемы.
Схема с входами и выходами сама не имеет системных атрибутов (кроме
собственно атрибутов входов и выходов). Вы можете назначать эти атрибуты,
если Вы компилируете схему как тип блока (см. Раздел  3.9.2).
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Замечания:
• Вы можете соединять несоединенные входы и выходы с входами и

выходами схемы только при соответствии типов данных соединяемых
входов и выходов.

• Если входы и выходы уже соединены, тип данных изменить невозможно.

• Выходам схемы не могут назначаться параметры, если они соединены.
Исключение: Вы назначаете параметры выходам блока; эта величина
вводится затем для соответствующего выхода схемы.

• Вы можете назначать вход схемы нескольким входам различных блоков
или схем.

Назначение входов и выходов, когда схемы уже установлены
Вы также может расширить схему, добавив входы или выходы. Если это
вложенная схема (см. также 3.2.4), другими словами, схема, которая уже
установлена в другую схему, дополнение входов и выходов может привести к
конфликту размещения схемы на листе. В таком случае,  вложенная схема
отображается подобно перекрывающимся блокам; другими словами,
выделяется серым, а входы и выходы не изображаются.
Как только схема будет перенесена в свободное место, входы и выходы
соединения станут снова видимы.
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3.2.4 Создание вложенных схем

Вы можете вставлять одну схему CFC в другую. Это позволяет Вам создавать
программу, структурированную соответственно Вашим технологическим
требованиям, повторно используя типовые части программы.
Схемы, вложенные в другую схему, могут быть открыты и изменены в режиме
редактирования, исполняются и контролируются в тестовом режиме.
Схема, содержащая вложенные схемы, является главной схемой в SIMATIC
Manager. В папке схем Вы можете увидеть только главную схему.
Максимальная глубина вложенности для схем – 8 (главная схема + 7 уровней
вложенных схем).

Вставка схемы в схему
Вы можете перетащить новую схему в текущую схему из каталога блоков
(иконка  “New Chart” («Новая Схема»)) и продолжить редактирование. Если
Вы используете команду меню "Insert > New Chart" ("Вставить > Новая
Схема"), автоматически будет осуществлен поиск свободной позиции в схеме
(в просмотре текущего листа) и новая схема будет помещена в найденную
свободную позицию.
Схемы используются в CFC подобно блокам, они показаны в каталоге схем в
виде дерева. Оттуда Вы можете перетащить схему в текущую открытую
схему. Когда Вы вставляете схему, то копируете ее вместе со всеми
вложенными схемами (если она содержит дополнительные схемы).
Вы также можете поместить родительские схемы в схему путем
перетаскивания их мышью, удерживая нажатой клавишу Shift. В таком случае,
они не копируются, но перемещаются. В каталоге схема более не показана  в
месте ее предыдущего размещения, но она показана в иерархии активной
схемы.

Навигация в схеме
Для того чтобы открыть вложенную схему, выберите ее в родительской схеме
и подайте команду меню "Open" с помощью правой кнопки мыши или меню
"Edit". Вы также можете открыть схему двойным нажатием на свободной
позиции (не на заголовке и входе или выходе). Повтором этого Вы можете
спуститься к самой нижней в иерархии схеме.
Для перемещения вверх по иерархии, выберите вложенную схему, затем
нажмите команду меню "Open Parent Chart" “Открыть Родительскую Схему” с
помощью правой кнопки мыши или меню “Схема”.
Также Вы можете открыть схему в каталоге схемы. Выберите схему и затем
выберите команду меню "Open" (“Открыть”) с помощью правой кнопки мыши.

Копирование вложенной схемы в другие CPU
Вы можете копировать вложенную схему и вставлять ее в другой CPU.
Позиция, в которую будут установлены блоки, определяется "Predecessor for
Installation"(«Предшественник для установки») схемы назначения. Рабочая
группа не копируется.
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Копирование и удаление
Если Вы хотите удалить вложенную схему из родительской схемы, но не из
папки схем (например, Вы можете изменить ее и использовать позже),
сначала скопируйте ее в папку схем. Из открытой схемы (активной) выберите
команду меню "Chart > Copy to Chart Folder" (“Схема > Копировать в папку
схем"). Схема будет скопирована и вставлена в папку схем с новым именем.
Теперь Вы можете удалить схему.

Соединение
Если вложенная схема имеет входы и выходы, Вы можете соединить схему с
другими вложенными схемами, с блоками или с глобальными адресами.
Как назначать входы и выходы блока входам и выходам схемы, описано в
Разделе 2.4.1. Вы можете использовать эту процедуру, когда Вы хотите
соединить входы и выходы вложенной схемы с входами и выходами той
схемы, которая выше в иерархии.
Также Вы можете выполнить соединение, если Вы выбрали вход или выход
блока или схемы, а затем команду "Connection to Chart I/O..." (“Соединение с
входами и выходами схемы”) с помощью правой кнопки мыши или меню
"Insert" (“Вставка”). Окно "Chart Inputs/Outputs" (“Входы и выходы схемы”)
открывать не нужно. Диалоговое окно показывает список всех доступных
входов или выходов; другими словами, если Вы выбрали вход, в списке будут
элементы типа "IN", а, если Вы был выбран выход – то типа "OUT".

Замечание:
Помните, что схема, которую Вы вставляете путем перетаскивания из
каталога схем в текущую схему CFC, тоже копируется. Эта вложенная схема
не связана более с оригинальной схемой. Другими словами, изменения,
которые Вы сделали в одной из схем, доступны только в ней.

Замена
Вы можете заменить вложенную схему другими (вложенными) схемами.
Соединения “старой схемы” по возможности сохраняются в новой схеме.

Для перемещения вложенной схемы, перетащите новую схему из каталога
схем напрямую на заменяемую вложенную схему. Схема заменится, когда
курсор будет внутри схемы в нужной точке; появится запрос, хотите ли Вы
или нет заменить схему, согласитесь, нажав “ОК”.

Эту функцию «замена» можно использовать, например, если Вы
конфигурируете вложенные схемы как модульную функцию и предназначаете
их различным пользователям. Может возникнуть следующая ситуация:

Вы имеете вложенную подфункцию как вложенную схему и соединяете
вложенную схему со схемой. Подфункция – это, например, программа
контроллера для вентиляционной системы, которая зависит от различных
вариантов и места использования. Внутри структуры эти варианты могут
меняться без необходимости менять соединения.



Работа с редактором CFC

CFC для S7
A5E00177297-01 3-9

3.3 Обработка блоков

Блоки для CFC
Базовый набор блоков поставляется с CFC. Вы можете получать
дополнительные блоки из библиотек или других проектов.

Помощь
Интерактивная помощь обеспечивает описание блоков, поставляемых с CFC,
которые Вы можете посмотреть, нажав "Help arrow" («Указатель помощи») (в
схеме CFC, в папке блоков или каталога) или клавишу F1 для выбранного
блока.

Замечание:
[S7] "Библиотека CFC" содержит блоки для CPU 3xxx в папке "ELEM_300".
Эти блоки не могут выполняться на CPU 4xxx.

3.3.1 [S7] Импортируемые блоки

Импорт в CFC
Путем импорта существующие блоки становятся известными CFC. Вы можете
использовать такие блоки в CFC.
Вы можете импортировать блоки, вставляя их из каталога (скрытый импорт)
или с помощью команды меню "Options > Block Types..." ("Опции > Типы
блоков...").
Явный импорт используется всегда, когда Вам требуется импортировать
много различных блоков. Впоследствии, вставка из каталога намного
быстрее, поэтому неявный импорт более не нужен.
Вы можете использовать диалог "Block Types..." ("Типы блока..."), например,
когда Вы хотите импортировать несколько блоков из пользовательской
программы (папки блоков) в папку схем. Вы можете также использовать этот
диалог, когда Вы изменяете блоки (изменение типа) в папке блоков, которые
существуют с эти же именем в папке схем и должны быть обновлены в папке
схем.
Вы можете выбрать требующиеся блоки в окне "Offline block folder" ("Папка
блоков автономного режима") и затем импортировать блоки в папку схем,
перетащив их  мышью или кнопкой "-->". Если блок уже существует в папке
схем, появится сообщение.

Совет: Импортируемые блоки появляются в каталоге блоков в
соответствующем семействе блоков в разделе "All Blocks" (“Все блоки”).
Затем Вы только вставляете блоки в схему из этого каталога блока.
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Конфликт номеров
Если блок уже импортирован и существует с таким же именем объекта
(номер блока, например, FB61), но с другим символьным именем, откроется
диалог, в котором Вы можете переименовать блок (подобно SIMATIC
Manager, когда копируются блоки с одинаковым именем объекта).

3.3.2 [S7] Импорт новой версии

Если, вслед за изменением типа блока, Вы хотите использовать измененные
блоки вместо ранее использованных старых типов блоков, новые типы блоков
должны быть импортированы в папку схем. Экземпляр блока, используемый в
схеме CFC, может затем адаптироваться к изменению типа блока
(централизованное изменение типа блока).
Блоки импортируются следующим образом:

• Когда Вы вставляете измененный тип блока из программы S7 или
библиотеки блоков в схему.

• Используйте команду меню "Options > Block Types..." ("Опции > Типы
блоков...") в диалоге "Block Types" ("Типы блоков"). Здесь выберите блок,
импортируемый из списка исходных файлов ("Block Folder Offline"( "Папка
блоков автономного режима")) и перетащите блок в список "Chart Folder"
("Папка схем") (или нажмите кнопку "-->").

Использование новой версии
Если в папке схем уже существует тип блока с таким же именем, но с другой
версией, появится диалоговое окно "Import New Version" ("Импорт новой вер-
сии") с сообщением о последствиях и информацией, о версиях обоих блоков.
Если Вы отвечаете на вопрос "Do you still want to use the new version of the
block types?" ("Хотите ли Вы использовать новую версию типов блока?")"Yes",
все соответствующие экземпляры блоков изменяются. Если Вы отвечаете
“No”, адаптации не произойдет. Могут возникнуть три различные ситуации:

9. Изменения не требуют ни загрузки программы в целом, ни повторного
вызова передачи данных AS - OS (компиляция OS), поскольку они
действуют только внутри ES (например, входы и выходы блоков сделаны
невидимыми). В таком случае, Вам необходима только загрузка
изменений в режиме RUN.

10. Изменения, которые влияют на OS, поэтому требуется повторная
компиляция OS (например, после изменения текстов сообщений).

11. Изменения в структуре, например, добавление входов или выходов, а
также, возможно, и сообщений. Это приводит к следующим последствиям:
− Соединения и установки параметров теряются.
− Можно загрузить только программу в целом; другими словами,
потребуется переход CPU в режим STOP.

− Если блок предназначается для управления и мониторинга
оператором (другими словами, он будет выполняться на OS),
необходима также компиляция OS.

− Если Вы хотите сохранить настройки параметров на AS, перед
загрузкой схема должна быть выгружена из CPU.
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Замечание:
Централизованное изменение блока не выполняется, если изменена
категория типа блока (например, FB <--> FC).
Идея централизованного изменения типа блока относится к FB и FC. Типы
BOP не могут изменяться, поскольку они являются встроенной частью CFC.

Совпадение версий
Если Вы импортируете типы блоков, и такие же версии уже существуют в
папке схем, Вы будете проинформированы, что Вам не нужно импортировать,
и увидите список совпадающих типов блоков.

“Уборка” типов блока
С помощью кнопки "Tidy Up" («Уборка»), Вы можете удалить блоки из папки
схем и папки блоков, если они более не требуются в проекте.

CFC проверяет, какие типы блоков более не используется в одной из папок. В
зависимости от результатов проверки, откроется диалоговое окно для каждой
папки со списком неиспользуемых блоков. (Папка блоков: Типы блоков,
которые не импортированы в систему хранения данных CFC; Папка схем:
Типы блоков, экземпляры которых не существуют в схемах CFC). Вы можете
выбрать блоки для удаления в диалоговом окне.

Блоки в библиотеке
Если Вы изменяете тип блока, до этого находящийся в библиотеке,
пожалуйста, помните, что нужно включить блоки в программу S7 (папку
блоков) перед тем, как Вы обновите блоки в папке схем с помощью "New
Version" ("Новая Версия ").
Если Вы изменили тип блока внутри программы S7 (в папке блоков),
пожалуйста, помните, что библиотеку также можно обновить.

Протоколирование типов блока
Изменения в результате централизованного изменение типов,
протоколируются и автоматически отображаются после обновления. Вы
также можете посмотреть их, если требуется, распечатав  с помощью
команды меню "Options > Logs...: Block Types" ("Опции > Протоколы...: Типы
блоков "). Если необходимы изменения экземпляров блока, Вы можете
использовать протоколы чтобы помочь Вам как сэкономить время, так и
снизить риск ошибок.
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Допустимость импорта типа после расширения типа данных
Если тип данных для типа блока расширен, все данные входов и выходов
сохраняются при централизованном изменении типа, если старый тип данных
может отображаться на новом типе без преобразования. Это:
BYTE --> WORD
BYTE --> DWORD
WORD --> DWORD
INT --> DINT
STRING1n --> STRINGn+m (т.е. STRING16 --> STRING32)
Замечание:
Помните, что существующие соединения с этими входами и выходами не
менее теряются в результате централизованного изменения типа.

3.3.3 Влияние изменений типа на экземпляры блоков

Если описание интерфейса (входы и выходы блока) или системных атрибутов
типа блока меняются в схеме CFC, все экземпляры блоков автоматически
адаптируются. В зависимости от изменений интерфейса, это может влиять на
дальнейшие действия.

Влияние изменений на входы и выходы блока
• Вход или выход добавлен

Изменение выполняется также в экземплярах блока, и, по умолчанию,
присваивается системным атрибутам. Если они боле не умещаются  на
занимаемой позиции после увеличения размера блока, блоки становится
"перекрывающимися".

• Вход или выход удален
Вход или выход удаляется из экземпляров блока. Если вход или выход
был соединен, то соединение (или доступ SFC) также удаляется.
Удаленное соединение (или удаленный доступ SFC) вносится в протокол
изменений.

• Изменен порядок входов или выходов
Порядок входов или выходов принимается во внимание, а соединения,
назначение параметров и атрибуты сохраняются.

• Изменен тип данных входа или выхода
Все назначенные параметры и соединения этого входа или выхода
утеряны. Эта ситуация появляется, когда Вы удаляете и затем
восстанавливаете вход или выход.

• Изменено имя входа или выхода
Все назначенные параметры и соединения входа или выхода утеряны.
Ссылка на старое имя не может быть установлена системой
автоматически. Эта ситуация появляется, когда Вы удаляете и затем
восстанавливаете входы и выходы.
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Влияние изменения системных атрибутов
Если Вы изменили атрибуты, влияние резюмируется одним общим правилом:
Что не может быть изменено в экземпляре блока,  автоматически изменяется
в экземпляре как результат изменения типа.

Влияние на другие функции
• После этого нельзя загрузить только изменения (загружается только вся

программа).

• Функция "Read Back Chart" («Выгрузка схемы») далее невозможна,
поскольку блок в AS более совпадает с конфигурацией в CFC.

[S7] Влияние на WinCC
• Если изменен тип блока, DB с новыми номерами могут быть созданы при

сжатии и компиляции. Для гарантии сохранения интерактивного доступа,
данные должны быть переданы в WinCC заново (компиляция OS).

• Если вход или выход блока, предназначенный для управления и
мониторинга, затронут (атрибут S7_m_c=true), примените следующие
правила:

− Если добавлен вход или выход, он становится известен в WinCC при
компиляции OS и может там использоваться.

− Если вход или выход удален, тег WinCC более не существует.
Существующее соединение должно быть также удалено в WinCC.

− Если изменено имя входа или выхода, имя тега WinCC также
меняется. Соединения элементов рисунка, иконок блоков и лицевой
панели должны адаптироваться.

• Всякий раз при изменениях, влияющих на WinCC, необходима новая
компиляция OS.
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3.3.4 Вставка блоков в схему

Вставка в схему
Вы можете вставлять блоки, как при просмотре листа, так и в обзоре схемы.

Вы можете выбрать тип блока из других схем, из каталога блоков или
библиотек, и перетащить его в свою схему. Он автоматически копируется в
текущую программу S7 и импортируется в схему CFC. Изменения затем
появляются в каталоге блоков (в семействе блоков CFC и в разделе “All
blocks” ("Все блоки")).

Если Вы перетащили блок туда, где не было достаточно свободного места
для текущего размера блока, блок вставится как "перекрывающийся". Входы
и выходы перекрывающегося блока не отображаются, а заголовок и тело
выделены серым. Как только Вы перенесете этот блок на свободную
позицию, он будет показан как обычный.

Если Вы хотите вставить блоки из каталога блоков "Программы S7",
пожалуйста, помните следующее:

Блоки в программе S7 еще не известны CFC (даже если блок такого типа уже
импортирован). Это значит, что когда Вы хотите вставить блок из программы
S7 в схему, всегда выполняется проверка, импортирован ли уже блок.

Блоки, которые уже были импортированы в одно семейство блоков или, если
блок не назначен в семейство (определено в заголовке), он будет в папке
"Other Blocks" (“Другие блоки”). Есть также список в алфавитном порядке в
папке "All Blocks" (“Все блоки”).

Замечание:
Вставка блоков из семейства блоков является самым быстрым способом
помещения блоков в схему, поскольку не требует проверки. Вы выбираете
этот метод, когда тип блока уже импортирован.

Автоматическое назначение имени
Когда Вы вставляете блок в схему, блоку назначается его имя по умолчанию.
Каждый раз, когда Вы вставляете новый блок (копированием или
перетаскиванием из каталога), ему назначается то же имя с добавлением
очередного номера.

Если Вы изменяете имя по умолчанию, то это правило применяется и к
измененному имени блока при копировании или перемещении:
Если  в результате копирования получается два блока с одинаковым именем,
добавляется номер (без скобок). Если последний символ измененного имени
- число, оно увеличивается.

примеры:
     
Блок 2 копия 3
Блок: REG копия REG1
Блок: REG3 копия REG4
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Определение свойств стадии выполнения
Когда Вы вставляете блок, должны быть также определены свойства стадии
выполнения, например, указано, как блок вставляется в последовательность
выполнения.
Правило по умолчанию: Блок всегда вставляется после блока, показанного в
строке состояния.
Вы можете изменить позицию установки, выбрав блок, который считается
"предшественником" для последующей установки, а затем подав команду
меню "Edit > Predecessor for Installation" ("Редактор > Предшественник для
установки").
Текущая точка вставки показана справа в строке состояния. Показано имя
задачи, а также схема и имя блока, после которого будет установлен
следующий блок в последовательности выполнения, когда блок вставляется
в схему CFC.
Для более подробной информации о рабочих свойствах смотрите Раздел 3.7

Выравнивание блоков в схеме
Вы можете автоматически выровнять блоки в схеме, даже после того как они
соединены (команда меню: "Edit > Align > Left / Right / Top / Bottom"
("Редактировать > Выравнивание > Влево / Вправо / По верху / По низу")).
Исключение: Эта команда меню не работает, если выбран перекрывающийся
блок.
Блоки выравниваются по видимой графической границе блока (не фрейм
выбранного блока). По самому дальнему блоку слева или справа , вверху или
внизу решается, где выравнивать блоки.
Если выравнивание привело к конфликту, например, блоки перекрываются,
появится сообщение и сохранится старая ситуация. В таком случае, блоки не
выравниваются, даже те, которые могут выровняться без перекрытия.

Вставка и редактирование текстовых окон

Вы можете перетащить текстовое окно (иконка:  New Text (Новый текст)) из
каталога блоков и вставить его в любую точку схемы. Вы можете ввести текст
после того, как Вы откроете текстовое окно простым нажатием. Вы можете
настроить размер окна по вводимому Вами тексту.
Для более подробной информации смотрите интерактивную справку.
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3.3.5 Копирование и перемещение блоков

Вы можете копировать или перемещать блоки внутри схемы или в другую
схему. Также возможно скопировать или переместить несколько или все
блоки схемы вместе. Это позволяет Вам быстро и без ошибок дублировать
тестируемые подструктуры.
Возможно, копировать блоки в другие CPU. Это влияет на функциональность
так же, как и копирование схем в другие CPU.
Скопированные блоки вставляются в другую схему в ту же точку  на одну
ячейку сетки справа и ниже. Такая позиция значит, что блок также
вставляется на лист с подобным номером листа.
Если объект уже перемещен в позицию, блоки показаны как
перекрывающиеся, в ином случае они показаны нормально. Вы можете
переместить блоки в нужную точку (это не обязательно, поскольку даже
перекрывающиеся блоки могут выполняться на AS).
С точки зрения рабочих свойств и последовательности выполнения,
поведение копирования похоже на вставку из каталога; другими словами,
место вставки определяется "предшественником для установки".
Если блоки были установлены в рабочую группу, рабочая группа не
копируется.
Насколько возможно, имя блока сохраняется. Если есть конфликт, к имени
добавляется номер.
Обратитесь к интерактивной справке.

3.3.6 Удаление блоков

Если Вы удалили блоки, все соединения между удаленными блоками и
объектами, которые Вы не удалили, теряются.
Если выход соединен с блоком, который Вы не удалили, появляется
предупреждение. Если Вы решили удалить, входу блока, который не удален,
вместо удаляемого соединения, будет назначена величина параметра по
умолчанию.
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3.4 Редактирование блоков

Редактирование блоков в схеме означает изменение их свойств.
Свойства могут относиться к блокам в целом или к отдельным выходам и
входам. Установка свойств входов и выходов описана в Разделе 3.5.

3.4.1 Установка свойств объекта

Диалоговое окно “Properties – Blocks” ( "Свойства - Блоки") содержит
несколько станиц, в которых Вы задаете свойства. Это следующие страницы:

Страница “Global” ("Общее")
Здесь Вы можете увидеть все свойства, которые Вы назначали при вставке
блоков (и системные настройки в графе "Специальные свойства объекта”).
Имя блока уникально во всей схеме и показано в заголовке блока (максимум
16 символов).
Комментарии  - это свободно выбираемый текст в заголовке блока
(максимум 14 символов). В маленьких блоках комментарии не показаны.
Установите опцию "Operator C and M possible" ("Возможно наблюдение и
управление оператором"), когда Вы предполагаете использовать блоки
управление и мониторинг блоков в OS. Она активирует кнопку "Operator
Control and Monitoring" ("Наблюдение и управление оператором") и графу
"Block icon» ("Иконка блока").
Кнопка "Operator Control and Monitoring" ("Наблюдение и управление
оператором ") открывает диалог, в котором показан блок управления
входами и выходами с его атрибутами WinCC, которые здесь можно
редактировать.

Блоки, предназначенные для контроля и мониторинга, могут быть показаны в
WinCC с помощью иконки блока (с которой можно вызвать лицевую панель).
Если для типа блока доступны различные иконки блоков, то различные
варианты типа могут различаться (например, блок MOTOR как мотор,
вентилятор, насос и т.д.), они могут назначаться определенным экземплярам.

В поле входа Вы определяете, какая иконка блока будет для него показана в
WinCC.

Нажав кнопку "Messages" (“Сообщения”), Вы можете открыть диалог для
конфигурирования сообщений.

Страница "Inputs/Outputs" (“Входы и выходы”)
Вы можете назначать параметры и комментарии для входов и выходов блока,
включать их в список отладки и т.д., см. Раздел 3.5.
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3.4.2 Изменение числа входов и выходов

Если блок имеет переменное число входов и один тип данных, например
NAND, OR, Вы можете изменить количество входов блока, используя команду
меню "Edit > Number of I/Os..." (“Редактировать > Число входов и выходов”).
Число входов настраивается по Вашему выбору в диалоговом окне.
Добавление входов должно быть в пределах свободной площади блока, в
ином случае, блок будет показан как перекрывающийся.
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3.5 Изменение свойств входов и выходов

Вы можете изменить свойства входов и выходов блока. Этой цели служат два
диалога:

• Диалог для редактирования всех входов и выходов блока на странице
"Inputs/Outputs"  ("Входы/Выходы") диалогового окна "Properties - Block"
("Свойства - Блок") отображается двойным нажатием на блок. На
странице "Inputs/Outputs" ("Входы / Выходы") Вы увидите все свойства
входов и выходов в форме таблицы.

• Для простых входов и выходов, откройте диалоговое окно "Properties -
Input/Output" ("Свойства - Вход/Выход")  двойным нажатием на
требующийся вход или выход блока.
В зависимости от свойств и типа данных входа или выхода блока,
диалоговое окно будет содержать различную информацию, часть из нее
доступна для редактирования, а часть – только для чтения.

Замечание:

В диалоге свойств Вы можете ввести модули для редактирования
непосредственно или из списка выбора. В зависимости от области
приложения, требующейся пользователю, их можно расширять или изменять
при необходимости (обратитесь к интерактивной справке). Используя модули
из этого списка, Вы добиваетесь единой записи в различных приложениях
(например, обработка списка тегов, Редактор CFC, Редактор SFC) и
предотвратите проблемы, которые могут появляться при использовании
специальных символов.

3.5.1 Инвертирование входа блока

Бинарные входы можно инвертировать. После инверсии, "0" станет"1", а "1"
станет "0". Это возможно только для соединенных входов.

Установка инверсии
Вы инвертируете соединенный бинарный вход, выбрав вход и нажав на

иконку   на панели инструментов или выбрав команду меню "Edit > Invert
Input"  ("Редактировать > вход") или "Invert" (“Инвертировать”) в контекстном
меню.
В качестве альтернативы, Вы можете дважды щелкнуть на входе блока для
того, чтобы открыть диалоговое окно свойств входа и затем поставить
галочку в бокс выбора "Inverted" (“Инвертировать”).

Удаление инверсии
Для того, чтобы удалить инверсию, повторите функции, описанные выше.
Вы можете также отменить инверсию, удалив соединение входа или
переместив его в другой вход, или создав новое соединение.
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Замечания:
• Если Вы копируете сигнал с инвертируемого входа на другой вход, новый

вход не будет инвертирован автоматически. Вы должны инвертировать
его специально.

• Если Вы перемещаете соединение от инвертированного входа к не
инвертированному, новый вход не будет автоматически инвертироваться
и инверсия будет удалена.

• Входы, присваиваемые входам и выходам схемы, не могут быть
инвертированы.
Решение: Вставьте в соединение блок NOT.

3.5.2 Идентификаторы величин

Кроме идентификаторов "Text for 0" ("Текст для 0") и "Text for 1" ("Текст для 1")
для булевских величин 0 и 1, идентификаторы величин возможны также для
некоторых типов числовых данных (BYTE; INT, DINT, WORD, DWORD).

Создание идентификаторов величин
Используя идентификаторы величин для величин параметров блока или
входов и выходов схемы, Вы можете определить символические имена. Вы
выполняете описание с помощью системных атрибутов (от "S7_string_0"  до
S7_string_25"), когда Вы создаете тип блока или входы  и выходы схемы.
Текст для "S7_string_0/1" может иметь максимум 16 символов, а для
"S7_string_2 до 25"  - 8 символов. Отображаются только 8 символов. Если Вы
используете более 8 символов, Вы можете решить, какие из них будут
показаны. Для этого включите символ "=" в текст.

• Если знак равенства (=) включен в текст, будут показаны первые 8
символов справа от знака равенства.
Пример: Motor=ON; Motor=OFF4567890; показаны ON или OFF45678.

• Если текст не содержит знака равенства, будут выведены первые (слева)
8 символов.

Отображение и изменение в схеме
Для типа данных BOOL, идентификаторы величин для "Text for 0" ("Текст для
0") и "Text for 1" ("Текст для 1") могут изменяться в каждом экземпляре блока,
если для входов и выходов типа блока определен системный атрибут. Для
всех других типов данных, индивидуальное изменение в экземпляре блока
невозможно.
В схеме Вы можете решить, будет ли показан идентификатор символьной
величины или абсолютная величина. В диалоговом окне "Customize Layout",
Вы можете активировать или деактивировать "Параметр: Идентификатор
величины " ("Options > Customize > Layout...").
Если идентификаторы величины определены для входа или выхода, Вы
можете выбрать их из диалога свойств. Окно "Value" ("Величина") содержит
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дополнительную кнопку для открытия выпадающего списка. Выбранный
идентификатор величины затем будет показан на входе и выходе.

3.6 Соединения

В схеме CFC, соединение – это соединение между

• Выходом блока или схемы и

− одним или более входами другого или этого же блока или схемы

− выходом схемы

− рабочей группой (только для типа данных BOOL)

− объектом вне управления данных CFC (например, глобальные адреса)

• Входом блока или схемы и

− входом или выходом схемы (со схемой)

− объектом вне управления данными CFC (например, глобальные
адреса)

• Типы данных входа и выхода должны быть совместимы. Соединяемые
блоки или схемы могут быть на одном листе, на разных листах одной
схемы или в разных схемах на одном CPU.

Специальная форма соединения блока – текстовое соединение, когда
партнер соединения может находиться в разных папках схем или даже еще
не известен (см. Раздел 3.6.3).

Замечание:
Каждый соединенный вход или выход блока показан на схеме с коннектором.
Входы, которые не могут быть соединены, так как имеют атрибут "S7_link :=
false", визуально отличаются тем, что у них пропущен коннектор.
Такие входы не могут быть соединены ни с входами и выходами блока, ни с
вложенной схемой, ни с глобальными адресами. Если, однако, схема CFC
имеет входы и выходы, можно соединить такие входы с входами и выходами
собственной схемы.

Вы также можете изменить, скопировать и удалить эти соединения.
Отслеживая сигналы (см.3.6.5) и используя панель листа, Вы можете
передвигаться по схеме.
Соединения, переходящие от одного листа к другому или от одной схемы к
другой, легко можно создать, открыв одновременно несколько окон и
используя просмотр листа.

Замечание:
Специальные правила соединения применяются к входам и выходам блока
со следующими типами данных: ANY, STRING, STRUCT, и DATE_AND_TIME:
Для более подробной информации читайте правила соединений в
интерактивной справке.



Работа с редактором CFC

CFC для S7
A5E00177297-01 3-22

3.6.1 Соединения с глобальными адресами

Глобальные адреса это соединения с конечными точками, расположенными
вне схем CFC. Разные целевые системы имеют разные глобальные адреса
(например [S7], в глобальном блоке данных, сигналах на входах и выходах,
меркерах, таймерах, счетчиках).
Для выбранного входа или выхода, Вы можете показать список адресов с
помощью команды меню "Interconnection to Address" ("Соединение с
адресом"). Он содержит все символы текущей символьной таблицы, которая
применима для этого входа или выхода; другими словами, имеет
совместимый тип данных.
Для более подробной информации о возможных соединениях и примеры
символьных и абсолютных адресов смотрите интерактивную справку.

3.6.2 Соединения с рабочими группами

Вы можете динамически разрешать и запрещать рабочие группы. Это значит,
что выходная величина блока определяет, выполняется ли или нет рабочая
группа. Чтобы добиться этого, соедините бинарный выход блока с атрибутом
разрешения рабочей группы.

Вставка
С помощью команды меню "Insert > Interconnection to Run-Time Group"
“Вставка > Соединение с рабочей группой”, Вы открываете диалоговое окно
со списком всех задач CPU и списком соответствующих рабочих групп. После
выбора нужной рабочей группы (двойной щелчок), соединение вводится в
интерфейсную панель листа.

Удаление
Если Вы удаляете рабочую группу, соединение автоматически будет удалено.
Атрибут разрешения рабочей группы устанавливается в "1".
Для того, чтобы удалить рабочую группу, выберите маленькое поле в панели
листа и нажмите клавишу "Del" («Удалить»).
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3.6.3 Текстовые соединения

Текстовые соединения могут находиться только на входе блока или схемы и
относиться к выходу блока или схемы CFC. Текстовое соединение остается
“открытым” и становится “действительным” соединением только при
замыкании.

Замкнутые текстовые соединения – это адресация входа с помощью строки
символов, которые идентифицируют конкретное соединение-источник
(выход).

Источник
Текстовое соединение появляется

• автоматически, как путь ссылки (вход или выход схемы или блока) с
путем PH (если он существует), при копировании или перемещении в
другую папку схем. При копировании, текстовое соединение появляется
на входе копии, и при перемещении, как на перемещенном объекте, так и
на оставшемся объекте, если соответствующий выход не остается в той
же папке схем. Соединение на выходе удаляется, если вход не остается в
этой папке схем.

• когда вводится пользователем на вход (выберите вход и нажмите правую
кнопку мыши или команду меню «Insert > Textual Interconnection» («
Вставка>Текстовое соединение»)
− как путь ссылки (вход или выход схемы или блока) с путем PH (если он
существует).
Соединение немедленно закрывается, если партнер соединения
находится в этой же папке схем. Если партнер соединения был
помещен в папку схем позже, соединение можно закрыть, используя
команду меню "Options > Make Textual Interconnection" (“Опции >
Выполнить текстовое соединение”). Получаем реальное соединение
блоков.

− как запрос соединения (любая строка символов, содержащая
конкретный путь ссылки, например, комментарий). Этот запрос
соединения не может быть закрыт (предупреждение регистрируется) и
должен быть соединен пользователем вручную.

• при централизованном изменении типа, если тип данных соединенных
входов и выходов не соответствуют друг другу после изменения.

Пожалуйста, помните, что текстовое соединение не даст результата

• если источник соединения удален. В этом случае удалено реальное
соединение.

• с внутренним соединением и соединением с входами и выходами схемы,
когда источник соединения (вложенная схема или блок) удалены или
перемещены. В таком случае назначение к входам и выходам схемы
потеряно.

• когда централизованно изменен тип, включая изменение имени с
изменением интерфейса. Замечание: если изменено имя без изменения
интерфейса, соединение сохраняется.
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Отображение в панели листа
Открытое текстовое соединение (партнер соединения не находится в папке
схем или ссылка не совпадает с существующим входом или выходом блока):
В большом поле панели листа Вы видите введенный текст (одна строка).
В маленьком поле показан идентификатор, как желтый треугольник.

При закрытии текстовое соединение преобразуется в реальное, другими
словами, в обычное соединение блока.
Идентификатор в маленьком поле (желтый треугольник) исчезает.

Изменение текстового соединения
Вы можете изменить текстовое соединение следующим образом:

• Еще раз присоединить к другому входу с тем же типом данных.

• Отредактировать текст в панели листа. Двойным нажатием на большое
или маленькое поле панели, Вы открываете диалоговое окно для ввода
нового текста. Предыдущий текст выделен, и его можно переписать.

• Вы можете заменить тестовое соединение:

− соединением с глобальным адресом: Выберите вход или текст в
панель листа, нажмите правую кнопку и выберите "Interconnection to
Address..." (“Соединить с адресом…”).

− соединением с ходом или выходом схемы: Выберите вход или текст в
меню нажмите правую кнопку и выберите "Interconnection to Chart
I/O...”Соединить с входами и выходами схемы…”. В диалоговом окне
Вы найдете в списке все сконфигурированные входы и выходы
текущей схемы и их тип (IN, OUT, INOUT).

Замыкание открытого текстового соединения
Когда все партнеры текстового соединения находятся в папке схем, Вы
можете закрыть его, преобразовав в реальное. Для этого есть два пути:

• С помощью команды меню "Options > Make Textual Interconnection"
("Опции > Выполнить текстовое соединение "), Вы можете замкнуть все
текстовые соединения в текущей папке схем.
Некоторые текстовые соединения не могут быть замкнуты.

Генерируется протокол всех замкнутых и еще открытых текстовых
соединений (Logs > Textual Interconnections tab  (Протоколы > Страница
текстовых соединений)).

• Перед компиляцией, если опция "Make Textual Interconnections"
("Выполнить текстовое соединение ") установлена в диалоговом окне
"Compile Charts as Program" ("Компиляция схем как программы").

Если одно или несколько текстовых соединений не могут быть замкнуты, это
отмечается в протоколе.

Компиляция продолжается и для входа генерируется подстановочное
значение (величина по умолчанию для типа блока). Соединение на выходе
игнорируется.
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Удаление и поиск текстовых соединений
С помощью команды меню “Options > Delete Textual Interconnections...”,
(“Опции > Удалить текстовые соединения...”). Вы открываете диалоговое
окно со списком всех текстовых соединений.

В этом окне Вы можете выполнить следующее:

• Получить обзор всех существующих текстовых соединений в текущей
папке схем. С помощью кнопки "Cancel", Вы выходите из диалогового окна
без удаления соединения.

• Используйте кнопку "Go To" («Перейти») для отображения схемы, в
которой было установлено соединение. Соединение загорится.

• Выберите текстовое соединение и удалите его из папки схем с помощью
кнопки "Delete" («Удалить»). Соединение будет немедленно удалено без
запроса о подтверждении.

Общая информация:
• Текстовое соединение может иметь максимум 512 символа.

• Текстовое соединение может сосуществовать с замкнутым соединением
или с другим текстовым соединением.

• Когда текстовое соединение замкнуто, действия и сообщения об ошибках
регистрируются и отображаются. Вы можете просмотреть протокол в
любое время с помощью команды меню "Options > Logs > Make Textual
Interconnections tab" («Опции > Протоколы > Выполнить текстовое
соединение»).

• При компиляции открытое текстовое соединение допустимо, а именно,
генерируется предупреждение и компиляция продолжается так, как
описано ниже:

− Вход: Генерируется код и для открытого соединения используется
величина, определенная по умолчанию для типа блока.

− Выход: Сгенерированный код игнорирует соединение.
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3.6.4 [S7] Соединение со схемой SFC (CFC в PCS 7)

Доступ SFC
Специальная форма соединения – прямой доступ SFC в действиях (actions)
или переходах (transitions) к входам или выходам (блока или вложенной
схемы) в схеме CFC. Этот тип доступа SFC может быть "перемонтирован" в
схеме CFC; другими словами, он может быть перемещен из одного входу или
выходу к другому с совместимым типом данных. Если вход или выход
соединен, Вы можете решать, переместить ли только доступ SFC или и
соединение.

• Перемещение только доступа SFC: Удерживая клавишу ALT,
перетащите выбранный вход или выход на требуемый новый вход или
выход. Символ доступа SFC переместиться на новый вход или выход;
существующее соединение перемещено не будет.

• Перемещение соединения и доступа SFC: Перетащите выбранный вход
или выход на новый. Появится сообщение: хотите ли Вы переместить и
доступ SFC. Если Вы ответили "да", соединение и доступ SFC будут
перемещены, если Вы ответили "нет", переместится только  соединение.

• Удаление доступа SFC: Вы не можете удалить доступ SFC в схеме CFC.
Доступ SFC в схеме CFC показан маркером на входе или выходе блока.
Доступ для записи и чтения показан по разному.
Маркер над входом или выходом означает "доступ чтения" и ниже входа или
выхода - "доступ записи". Цвет маркера такой же, который используется при
индикации типа данных соединения.

Ссылки SFC
Вы можете отобразить ссылки SFC в диалоге "Properties - Inputs/Outputs"
(«Свойства – Входы/Выходы»).  Если вход или выход включает доступ SFC,
диалоговое окно содержит кнопку "SFC Access..." («Доступ SFC»), с помощью
которой Вы можете просмотреть окно со списком ссылок SFC.
Дважды нажмите на имя в списке схем SFC, чтобы открыть нужную схему, где
есть объект ссылки.
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3.6.5 Обработка соединений

Трассировка сигналов
В случае когда на листе показано много соединений, Вы можете, тем не
менее, проследить путь отдельного соединения.
Нажмите на линию или большое поле в панели листа, все линии и вводы
панели, включая страницы переполнения, соединенные с выбранной линией,
будут выделены вспышкой. Вы можете трассировать сигналы по ветвям
линий и за коннекторами.
Начиная от входов и выходов вложенной схемы, сигнал может проходить к
входам и выходам, которые соединены с ними непосредственно. Нажав
правую кнопку мыши и выбрав команду меню "Track Signal" (Трассировать
сигнал), Вы открываете вложенную схему; соединение, включая вводы в
панели листа, будут выделены вспышками.
Чтобы отменить вспышки, просто нажмите на любое свободное место в
схеме.

Переход в панель листа
Вы можете перейти из ввода в панели листа или страницы переполнения к
соединенному с ним блоку на другом листе текущей схемы или другой схемы:

• Если Вы переходите от ввода в панели листа или из входа или выхода с
простым соединением, переход выполняется немедленно.

Появляются лист или схема, в которых находятся блок или вложенная
схема. Для соединенных блоков, активируется сигнал трассирования
(вспыхивает линия), для вложенной схемы, выбирается соответствующий
вход или выход этой схемы.

Если переход выполняется в перекрывающийся блок, блок сдвигается в
центр экрана и выделяется. Так как вход или выход и линии соединения
не могут быть показаны, трассировка сигнала невозможна.

• Если Вы переходите от выхода панели листа, который имеет более чем
одно соединение, откроется диалог со списком всех соединений этого
выхода. Переход выполняется, когда Вы дважды щелкните по нужному
входу или выходу (или выберите его и нажмете "OK").

• С помощью команды меню "Edit > Go To > Jump Back" ("Редактировать >
Перейти > Вернуться"), Вы вернетесь в точке, с которой Вы начали
переход, даже если Вы закрыли выбранную схему или удалили блок.

Копирование соединений
Для того, чтобы копировать соединение, выберите вход соединения и,
удерживая клавишу Ctrl, перетащите мышью его к нужному входу (того же
типа). Когда Вы достигните нужного входа, сначала отпустите кнопку мыши и
только затем клавишу Ctrl. Будет создано дополнительное соединение.
Копирование таким образом очень удобно, когда соединяются блоки из
разных схем, так как Вам не нужно повторно находить источник.
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Изменение соединения (перемонтаж)
Вы можете переместить существующие соединения из одного входа в другой
или из одного выхода в другой.

• Вход:

Позиционируйте указатель на входе, Если Вы хотите переместить
соединение на другой вход и удерживайте кнопку мыши. Затем
перетащите указатель мыши к другому входу (того же типа) и отпустите
кнопку. Линия соединения перечертится.

• Выход:

− Если у Вас множество соединений, все они будут переключены к
новому выходу.

− Если Вы перетащили соединение с адресом к выходу, который уже
соединен с этим адресом, появится предупреждение. Вы можете
решить, сохранить соединение с исходным блоком или удалить его.

Если Вы хотите перемонтировать соединение с доступом к схеме SFC,
появится запрос, хотите ли Вы переместить и доступ SFC.

Удаление соединений
Вы можете удалить соединение следующим образом:

• Многократное соединение:

− Если Вы хотите удалить все соединения выхода, выберите выход или
линию (ии) соединения и команду меню "Edit > Delete"("Редактировать
> Удалить") или нажмите клавишу DEL.

− Если Вы хотите удалить одно из нескольких соединений выхода,
выберите вход и нажмите клавишу DEL
или
установите курсор на вводе панели листа и нажмите правую кнопку
мыши. Выделится маленькое поле перед вводом панели листа.
Выберите "Delete Interconnection(s)" (“Удалить соединение(я)”) в
контекстном меню и соединение с входом будет  удалено. Вы можете,
конечно, нажать на маленькое поле в панель листа напрямую и
удалить соответствующее соединение с помощью DEL или "Edit >
Delete".

• Однократное соединение:

Вы можете выбрать выход, вход или линию соединения и удалить
соединение с помощью команды меню "Edit > Delete" или клавиши DEL.

Замечание: Доступ SFC не может быть удален в схеме CFC.
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3.6.6 Структуры

Использование структур позволяет поместить любые данные в древовидную
структуру и затем применять их в входах и выходах блока. При отображении
блока структура имеет имя входа или выхода и тип; тип обозначается "ST".
Структура состоит из нескольких элементов (с глубиной вложенности до 8
уровней):
• Элементарный тип данных (BOOL, WORD, .. )
• Структура
Элементы структуры содержат следующую информацию:
• Тип (элементарный тип данных, иначе "ST")
• Имя
• Величина (только для элементарного типа данных)

Соединение
Структурный вход или выход блока может быть соединен только с другой
структурой, но не с  элементарным типом данных. Соединяемые структуры,
должны быть совместимы, другими словами, порядок, тип данных и имена
элементов элементарных типов данных должны быть идентичны. Имя
структуры может отличаться.
Элементы из структуры не могут соединяться отдельно, только вход или
выход блока может быть соединен как структура.
Для более подробной информации обратитесь к интерактивной справке.

Редактирование элементов структуры
Вы можете отобразить свойства объекта, структуры или элементарного типа
данных в структуре и отредактировать ее (назначить параметры). Дважды
щелкните на входе или выходе блока для того, чтобы показался диалог
"Select Structure Element" (“Выбор элемента структуры”). В появившейся
структуре выберите элемент для редактирования и откройте диалог свойств
кнопкой "Properties" (или дважды щелкните на элементе). Диалоговое окно
доступно в режимах редактирования и тестирования.
Если Вы хотите посмотреть структуру в режиме тестирования, Вы можете
включить отдельный элемент структуры в динамический просмотр, открыв в
диалоговом окне "Select Structure Element" (“Выбор элемента структуры”)
контекстное меню "Include in Dynamic Display" (“Включить в Динамический
Просмотр”).

Замечание:
• В структуре системные атрибуты для “управления работой и

мониторинга” или “сообщение” не должны использоваться в любой точке.

• Структура не может быть отредактирована в SFC.
Вход или выход блока со структурой не может быть соединен с глобальным
адресом, который обращается к блоку данных в целом (DBx); соединения со
структурой внутри DB возможны (DBx.name_st).
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3.7 Свойства выполнения блоков

Свойства выполнения блоков определяют, как блок будет включен в
последовательность выполнения внутри структуры CPU. Эти свойства имеют
значение для поведения целевой системы в смысле времени реакции,
времени запаздывания или устойчивости структуры, зависящей от времени,
например, системы с обратной связью.

При вставке каждому блоку, по умолчанию, присваиваются рабочие свойства
путем их установки в последовательности выполнения задач (смотрите
также: Изменение последовательности выполнения, Раздел 3.7.2). При
применении блоки также можно установить в рабочую группу, которая в свою
очередь устанавливаются в последовательность выполнения задач.

Замечание: Когда Вы создаете новую схему, автоматически создается
рабочая группа, в которую устанавливаются все блоки этой схемы.

Рабочая группа используется для структурирования или организации
задания. Блоки последовательно устанавливаются в рабочую группу, которой
в диалоге свойств объекта можно давать атрибуты "scan rate" ("отношение
циклов") и "phase offset" ("смещение по фазе").
Каждый блок должен быть установлен в последовательности выполнения, по
крайней мере, однажды. Блок можно установить в несколько заданий, но
только один раз в одно задание.

Отображение рабочих свойств

Существует несколько путей отображения рабочих свойств; и тот и другой
для отдельного блока и для целого CPU.

Простой блок
Рабочие свойства каждого блока показаны в заголовке блока на выделенном
фоне.

 

AND 
TE_EN 

OB 33
2 / 3

Имя задания 

Положение рабочей группы в задании или
положение блока в задании 

Положение блока в рабочей группе 
(для блока в задании, здесь показано - �) 

Поле рабочих свойств
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CPU
Вы можете получить полный обзор последовательности выполнения
следующим образом:

• Двойным щелчком в окне рабочих свойств в заголовке блока. Запускается
редактор последовательности выполнения и в окне последовательности
выполнения открывается задача, в которой установлен блок (первый
указатель установки). Соответствующий блок будет выделен.

• Выбором команды меню "Edit > Run Sequence..." ("Редактор >

Последовательность выполнения...") или нажав кнопку .
Запустится рабочий редактор и появится окно с рабочей
последовательностью. Если блок выбран, откроется задание, в котором
установлен блок (указатель первой установки) в последовательности
выполнения. Соответствующий блок будет выделен.
В этом окне Вы можете редактировать последовательность выполнения
CPU. (см. раздел 3.7.2).

• Выбрав команду меню "Options > Chart Reference Data..." ("Опции >

Справочные данные схемы...") или кнопку .
Запустится отдельное приложение и кнопка команды меню /панели
инструментов.
В обзоре "Последовательность выполнения" (активируется кнопкой "View

> Run Sequence" («Вид > Последовательность выполнения») или  ),
показана полностью последовательность выполнения текущего CPU
(блоки с информацией о типе блока и комментарии). Откроется задание, в
котором установлен объект. Вы можете распечатать в виде списка обзор
последовательности выполнения.
В этом окне нельзя редактировать последовательность выполнения.

3.7.1  Модель последовательности CFC

Понятие модели последовательности
Модель последовательности позволяет структурировать последовательность
выполнения схемы; другими словами, блоки схемы устанавливаются один за
другим в последовательности их выполнения. Указатель установки определя-
ет следующую точку вставки. Это указатель установки и схемы и блока.

В программе S7, есть один (глобальный) указатель установки для схемы и
один локальный указатель для каждой схемы.

Вместе с рабочей группой, создаваемой автоматически для каждой схемы,
концепция указателя установки обеспечивает лучшую ориентацию в схеме.
Главным образом, это позволяет блокам схемы обрабатываться как группы,
при ветвлении и слиянии проекта в многопользовательской разработке. Это
позволяет Вам работать на основе технологии схема-в-схеме и определять
последовательность выполнения, не зависимо от последовательности
выполнения в других схемах.
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Если указатель установки не изменяется пользователем, установка
происходит таким образом:

• Новые схемы устанавливаются после существующих

• Блоки устанавливаются внутри схемы непосредственно один после
другого.

Дальнейшие шаги:

• Указатель установки нельзя переместить случайно при
многопользовательской разработке.

• Когда изменяется только одна схема, Вам не нужно компилировать и
загружать весь OB, а только рабочую группу изменяемой схемы.

• Использование CPU можно организовать на основе «схема-в-схеме».

• Выполнение отдельных схем в CPU может активироваться и
деактивироваться (даже в режиме тестирования) без внешнего запроса
контроллера (например SFC).

Указатель установки схемы
Каждая программа имеет свой глобальный "указатель установки схемы". Он
определяет

• OB, в котором будет установлена рабочая группа следующей схемы.

• Позицию, определяющую после какой рабочей группы (или после какого
блока на уровне OB) будет устанавливаться рабочая группа следующей
создаваемой схемы. Если OB еще не содержит рабочую группу, эта
позиция "пустая"; другими словами, указывает на сам OB.

По умолчанию указатель установки схемы OB35. Указатель устанавливается
только в редакторе последовательности выполнения (не в Редакторе CFC).

Смотрите также "Настройка указателя установки" в Разделе 3.7.2.

Указатель установки блока
Каждая схема CFC (включая вложенные) имеет свой "указатель установки
блока". Он определяет

• OB, в котором будет установлен следующий блок (основная установка).

• Позиция в последовательности выполнения, после которой установится
следующий блок. Позиция блока связана с уникальным номером OB.

Если схема пустая, указатель установки блока "не определен"; в строке
состояния, вместо него показан указатель схемы. После установки первого
блока, указатель переключится от текущего указателя установки схемы.

Указатель установки блока устанавливается только в Редакторе CFC (не в
редакторе последовательности выполнения). По умолчанию (после создания
новой схемы) он запускается при автоматическом создании рабочей группы.

Смотрите также "Настройка указателей установки" в Разделе 3.7.2
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3.7.2 Изменение последовательности выполнения и указателя
установки

Запуск рабочего редактора
С помощью команды меню "Edit > Run Sequence..." ("Редактировать >

Последовательность выполнения...") или нажав иконку  на панели
инструментов, Вы открываете широкое окно с окном иерархии слева и
подробным окном справа. Эта структура похожа на Windows Explorer и
аналогично работает.

Перемещение объектов
Вы можете переместить объект (схема, рабочая группа или блок), выделив
его (в правом или левом окне) и перетащив его на объект, после которого Вы
хотите установить его (перетащить).

Если Вы перетаскиваете объект в рабочую группу,

• объект устанавливается в первую позицию внутри рабочей группы, если
структура раскрыта [-].

• объект устанавливается после рабочей группы, если структура не
раскрыта [+].

• и если рабочая группа пустая: Вы получите запрос, хотите ли Вы или нет
установить блок внутри рабочей группы. Если Вы ответили “да”, объект
будет установлен внутрь, если Вы ответили “нет”, он встанет после
рабочей группы.

Если Вы перетащили объект на блок/схему внутри рабочей группы, объект
будет вставлен после этого блока/схемы.

Если Вы перетащили объект в задание, он вставляется перед
существующими объектами.

Замечание: При перемещении блоков, убедитесь, что все блоки схемы
находятся только в соответствующей рабочей группе. После перемещения
блока в другую рабочую группу, ориентированная на схему структура более
не существует и будет сложнее или вообще невозможна работа на основе
схема-в-схеме при многопользовательской разработке.

Удаление блока
Вы можете удалять блоки из задания только, если они установлены более
чем одного раза в последовательности выполнения. Блок должен оставаться
в последовательности выполнения, по крайней мере, однократно.

Если блок установлен только раз, Вы не можете удалить его. Если он
повторяется в последовательности выполнения несколько раз, блок будет
удален и последовательность выполнения блоков обновится.
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Установка блоков
Вы можете установить блоки, рабочие группы и схемы SFC несколько раз,
используя Copy (Копировать) и Paste (Вставить). Вы используете
соответствующие команды меню или иконки на панели инструментов или
перетаскиваете объекты, удерживая клавишу CTRL (см. также: перемещение
объектов).

Вы также можете установить блоки, перетащив их напрямую из схемы CFC в
требуемое место в последовательности выполнения (когда оба окна
показаны одновременно).

Замечание:
Объекты с системным идентификатором "@" устанавливаются в
последовательности выполнения автоматически, когда генерируются блоки
драйверов и могут редактироваться только функциями SIMATIC Manager
"Options > Charts > Generate Module Drivers..."( "Опции > Схемы >
Генерировать Драйверы модуля..."; другими словами, их нельзя переместить
или удалить вручную.

Настройка указателей установки
Вы можете изменить указатели установки следующим образом:

• Указатель установки схемы (по умолчанию OB35)
Для того, чтобы изменить указатель установки схемы, откройте редактор
последовательности выполнения и выберите нужный OB, или блок на
уровне OB (не внутри рабочей группы), или рабочую группу внутри OB.
В редакторе последовательности выполнения выберите команду меню
"Edit > Predecessor for Installation" ("Редактировать > Предшественник для
установки").

• Указатель установки блока
Вы не можете установить указатель установки блока в рабочем
редакторе. Для того, чтобы изменить указатель установки блока, откройте
Редактор CFC и выберите блок, после которого будут вставляться все
следующие блоки.
В схеме выберите команду меню "Edit > Predecessor for Installation"
("Редактировать > Предшественник для установки").

Если блок, выбранный как предшественник установки, удален, указатель
установки блока уменьшится, другими словами, начнет установку с блока,
размещенного перед удаленным. Это применимо и к случаю, когда блок
перемещается в другую схему. Указатель установки блоков в целевой
схеме не изменяется. Перемещенный блок сохраняет позицию установки,
которая была в предыдущей схеме.

Для более подробной информации смотрите интерактивную справку.
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3.7.3 Рабочие группы

Применение

Рабочие группы  необязательны, но они создаются автоматически при
создании новой схемы. Они используются для структурирования заданий
(OB). Блоки устанавливаются последовательно в рабочие группы.

С помощью рабочих групп Вы можете проделать следующее:

• Удалить или отсоединить выбранные блоки для выполнения на AS.

• Выполнить выбранные блоки с заданным коэффициентом сканирования
(каждый n-й цикл) и/или с смещением периода для того, чтобы лучше
сбалансировать загрузку CPU.

• Если OB содержит большое количество установленных блоков, они могут
быть вместе помещены в компактный модуль.
Преимущество: Вместо создания одной “большой” FC, когда Вы
компилируете каждый OB, "маленькие" FC создаются в зависимости от
числа рабочих групп.
Если программа изменена, только рабочие группы и FC, содержащие
изменения, имеют идентификатор "измененный". Это означает, что
последующая компиляция и загрузка изменений займет меньше времени.

• Когда выполняется разделение и слияние проекта для многопользова-
тельской разработки, это позволяет обрабатывать блоки схемы как
группы. Это позволяет Вам работать на основе технологии схема-в-схеме
и определять последовательность выполнения блока, не считаясь с
рабочей последовательностью в других схемах.

Как создать рабочую группу?
Рабочая группа создается двумя способами:

• Автоматически

Когда Вы создаете новую схему, новая рабочая группа автоматически
создается и устанавливается в последовательность выполнения согласно
указателю установки схемы. Эта автоматически созданная рабочая
группа имеет отличные свойства от рабочих групп, созданных вручную:

Автоматически созданная рабочая группа и схема имеют определенную
зависимость друг от друга, что сохраняется до изменений, выполненных в
рабочей группе. Изменение включает, например, изменение имени и/или
установки последовательности других блоков в эту рабочую группу.

Эта зависимость означает, что имя рабочей группы идентично имени
схемы и, если схема переименовывается, название рабочей группы
автоматически меняется. Если схема удаляется, рабочая группа также
будет удалена, если она станет пустой в результате удаления схемы.

Если эта зависимость более не действует (поскольку в рабочей группе
выполнены изменения) автоматически сгенерированная рабочая группа
ведет себя далее так же, как и рабочая группа, вставленная вручную.
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• Вручную

Вы можете создать рабочую группу вручную в любое время (создайте
новые группы с помощью команды меню или копируйте существующие
группы). Если Вы копируете рабочую группу и вставляете ее в
последовательность выполнения, к имени добавляется непрерывная
нумерация (без скобок).
Вы создаете рабочую группу путем выбора задания в левом окне, в
котором будет вставлена рабочая группа или в следующем объекте. С
помощью команды меню "Insert > Run-Time Group..." ("Вставить > Рабочая
группа..."), Вы запускаете диалог "Insert Run-Time Group" ("Вставить
рабочую группу”), в котором Вы можете задать свойства рабочей группы.

Редактирование и удаление рабочих групп
Вы можете отредактировать свойства рабочей группы позже.

Для редактирования, выберите рабочую группу (в левом или правом окне) и
затем команду меню "Edit > Object Properties..." ("Редактировать > Свойства
объекта...").
В диалоговом окне "Properties - Run-time Group" ("Свойства – Рабочая
группа") Вы можете изменить существующие величины (имя, комментарий,
смещение по фазе, отношение циклов).

Опции "Optimization of the run sequence" ("Оптимизация рабочей
последовательности") (см. Раздел 3.7.4) и "Active" "Активировать”
установятся по умолчанию. С помощью "Active" рабочая группа активируется
для работы в режиме тестирования (установка опции) или деактивируется
(отмена опции). Замечание: в системе F опция всегда установлена и не
может изменяться.
Вы можете удалить рабочую группу только, когда она не содержит объектов.
Для того, чтобы удалить рабочую группу, выделите ее и затем выберите
команду меню "Edit > Delete" ("Редактировать > Удалить") или нажмите
клавишу DEL.
Если удаленная рабочая группа была выделена как "Predecessor for
Installation" (“Предшественник для установки”), по умолчанию указатель
установки встанет на элемент задания, стоящий перед удаленной группой
или, если дополнительных элементов не существует, в начало задания.
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3.7.3 Оптимизация последовательности выполнения

Эта функция оптимизирует последовательность выполнения программы в
соответствии с потоком данных так, как это возможно по времени задержки
на CPU при выполнении программы. Различается оптимизация для OB
(задач) и рабочих групп.

Вы начинаете оптимизацию в рабочей группе, используя команду меню
Options > Optimize Run Sequence (Опции > Оптимизация
последовательности выполнения).

Что происходит во время оптимизации?
Это делается отдельно для каждой задачи. Рабочие группы обрабатываются
дополнительно вместе с заданием. Отношение циклов и смещение по фазе
рабочих групп игнорируются.

Поток данных получается из соединений. Он включает все соединения блока
с блоком, а так же схемами SFC и соединения выходов блоков с ENABLE
рабочих групп. Глобальные и текстовые соединения в расчет не берутся.
Соединения с интерфейсом схемы прослеживается вплоть до
действительного источника соединения. Если источника не существует;
другими словами, соединение заканчивается на интерфейсе, соединение
игнорируется. Соединения с блоками в других заданиях также игнорируются,
как и доступ из схемы SFC к входу или выходу блока.

Соединения внутри рабочей группы или вне рабочей группы считаются
соединениями самой рабочей группы, другими словами, рабочая группа
формирует функциональный блок на уровне задания. Соединения между
блоками рабочей группы используются только для оптимизации внутри
рабочей группы. Это гарантирует, что рабочая группа правильно
организована и что сама рабочая группа размещена в оптимальной позиции
задания.

Последовательная оптимизация выполняется так, что нет излишних
изменений и пределы изменений ограничены.
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3.8 [S7] Создание драйверов модулей

Для обработки сигналов в PCS 7, имеется возможность автоматической
генерации драйверов модулей и их соединения после того, как Вы создали
аппаратную конфигурацию с помощью HW Config и сконфигурировали
технологические функции в CFC. Эта возможность известна как "генерация
драйверов" в ES и может использоваться таким образом:

• Вы можете установить в диалоговом окне CFC опцию "Compile Charts as
Program" ("Компиляция схем как программ"). Драйверы модулей
генерируются перед компиляцией.

• При выборе папки схем Вы можете активировать функцию в SIMATIC
Manager с помощью команды меню "Options > Charts > Generate Module
Drivers...” ("Опции > Схемы > Генерировать драйверы модулей...").

Драйверы и сообщения, описанные здесь, могут использоваться только для
CPU S7-400.

Концепция драйвера и сообщения
Для этой функции используются типы блоков, имеющие эффект разделения
аппаратной и программной конфигурации:

• Канальные блоки вставлены в схему и соединены пользователем с
соответствующим именем сигнала из символьной таблицы. Этот сигнал
блока первичной обработки является частью технологической функции и
всегда обрабатывается вместе с ней.

Следующие типы доступны для первичной обработки сигнала:
− Стандартные канальные блоки: CH_AI, CH_AO, CH_DI, CH_DO.
Используются только для обработки сигналов сигнальных модулей S7-
300/400. Они используются, когда надо оптимизировать память и
последовательность выполнения, и не нужна обработка устройств PA.

− Универсальные канальные блоки: CH_U_AI, CH_U_AO, CH_U_DI,
CH_U_DO. Эти блоки используются для обработки сигналов
сигнальных модулей S7-300/400 или полевых устройств PA.
Преимуществом является то, что Вы можете создавать схемы CFC
независимо от модулей, которые можно определить позже. Однако
универсальные блоки требуют больше памяти и дольше выполняются.

− Канальные блоки PA:PA_AI, PA_AO, PA_DI, PA_DO, PA_TOT. Эти
блоки используются только для полевых устройств PA, когда
требуются специальные свойства этих устройств. В отличие от блоков
CH, обрабатывается не только сами сигналы, но и все переменные,
согласно выбранной конфигурации устройств в определенной
аппаратной конфигурации.

• Блоки для диагностики и мониторинга входных и выходных модулей,
полевых устройств, связи и для сигнализации и отображения событий и
состояния CPU генерируются автоматически системой (вставка в
системную схему из библиотеки блока генератором драйвера), с
назначением величин параметров и подключением.

Для более подробной информации о возможностях, функционировании и
сообщениях блоков CH, смотрите контекстную помощь (F1) для блока.
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Использование и выбор
Начиная с Версии CFC V5.2 + SP1, используется расширенная концепция
драйвера, в которой контроль генерацией драйверов работает с системой
метазнаний. Генератор драйвера работает согласно предыдущей и
расширенной концепции. Какая концепция используется в существующем
проекте, зависит от используемых блоков обработки сигнала (блоки CH).
Генератор драйвера ищет типы импортируемых блоков и проверяет версии
блоков CH. Предыдущая концепция используется, если блоки CH имеют
версию ниже 2.0.

Концепция расширенного драйвера
С концепцией расширенного драйвера, которую поддерживает большинство
модулей для устройств ET200M, ET200S, ET200X, PA, связи DP/PA, DP/PA-
Link, Y-Link, DP V0- / DP V1 Slave, повторители диагностики, полевые
устройства HART (диагностика) возможны и резервирование входных и
выходных модули для PCS 7 и точное определение канальных ошибок в
сообщениях. Возможна настройка данных конфигурации из SIMATIC PDM.
С новой моделью иерархичного соединения блоков драйвера вместе с
новыми блоками OB_BEGIN и OB_END для диагностики на CPU и соединения
(вместо MSG_CSF), успешно реализуется оптимизация последовательности
выполнения.

Когда используется расширенная аппаратная конфигурация, что требуется
для концепции диагностики и сообщения об ошибках и для обработки блоков,
система метазнаний также должна быть расширена в форме XML файлов. В
то же время, существующий файл XML не может быть изменен.

Базовая установка файлов XML (список объектов и список действий)
поддерживается Библиотекой PCS 7 и инсталлируется с помощью Setup.
Соответствующие папки "Объект" и "Действие" находятся в:
...Siemens\Step7\S7data\driver\...

Модель сессии для "Генерации драйверов модулей "
• Пользователь конфигурирует аппаратное обеспечение с символьным

именем сигналов на входах и выходах. Имя сигналов вводится в таблицу
символов непосредственно в HW Config (выбрать модуль, команда меню
в HW Config: "Edit > Symbols..." (“Редактировать > Символы»)).

• Пользователь конфигурирует технологические функции в CFC. Здесь
блоки CH_ blocks (или PA_ blocks) используются и соединяются с
именами сигналов из символьной таблицы ("Insert > Interconnection to
Address..." (“Вставка>Соединение с адресом»)).
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• Пользователь запускает генератор драйверов, который создает,
соединяет и назначает параметры всем драйверам модулей в SIMATIC
Manager с помощью команды меню "Options > Charts > Generate Module
Drivers..."  (“Опции>Схемы> Генерировать драйверы модулей»).
Следующие фазы выполняются автоматически:

− Определяются все канальные блоки (_AI, _AO, _DI, _DO),
используемые в схеме CFC. Затем обнаруживаются все входы и
выходы (например, величины, O_SP, I_OUT_D, ...), которые
соединяются с символами входных и выходных каналов,
сконфигурированными в HW Config. Для блоков PA_AO-/PA_DO
возможны и другие символы, необходимые для соединения. Здесь для
соединения необходим только "начальный" символ, другие
определяются и соединяются автоматически функцией "Generate
Module Drivers"  (“Генерировать драйверы модулей”). Используя
адреса символов и символьной таблицы, соответствующий модуль и
канал модуля определяется из данных аппаратной конфигурации. На
основе типа модуля, используется соответствующий тип блока
диагностики (MOD или PADP) и затем создается экземпляр блока в
системной схеме для каждого входного и выходного модуля.

− Параметры, необходимые для блоков диагностики, получаются из
данных HW Config и вводятся в экземпляры блока (также в блоке
SUBNET для оптимизации времени работы в ошибке OB).

− Создается соединение между канальным выходом блока MOD/PADB и
соответствующим входом на блоке CH. Если модуль поддерживает
“статус величины”, появляется адрес статуса величины и соединение с
блоком CH/PA.

Если выполнено изменение в конфигурации (аппаратной или программной),
изменения должны обрабатываться, используя генерацию драйвера.
Существующие блоки драйвера не удаляются и не создаются заново, просто
переназначаются параметры. Блоки, больше не требуемые, удаляются
(исключая включенные пользователем) и создаются дополнительные блоки.
Если типы блоков уже импортированы, они используются из системы
управления данными CFC, а не из библиотеки.
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Как работает “Генератор драйверов модуля”
Системные схемы генерируются автоматически и все необходимые блоки
диагностики вставляются в них. Системные схемы имеют имена "@1", "@2", и
т.д..

Замечание:
Объекты, идентифицированные символом "@", не могут изменяться
пользователем, можно только использовать функцию "Generate Module
Drivers" (“Генерировать Драйверы модулей”). Таким образом, блоки
диагностики не вставляются вручную.
Блоки драйверов, созданные пользователем, вставляются из каталога блока.
Если блоки "@" копируются, они в следующий раз удаляются функцией
"Generate Module Drivers".

Новые типы блока
Если установлена новая библиотека PCS 7 с измененными  блоками, это не
влияет на уже использованные блоки.
Если, однако, Вы хотите обновить блоки, проделайте следующие шаги:

• Удалите все системные схемы с @ из папки схем.

• Выберите команду меню "Options > Block Types..." («Опции > Типы
блока») и удалите соответствующие блоки в окне "папка схем" (выберите
блоки и нажмите кнопку "Tidy Up" («Уборка»)).

• В обзоре компонент SIMATIC Manager запустите функцию "Generate
Module Drivers" (“Генерировать Драйверы модулей”).
Будут созданы новые системные схемы и используются блоки драйверов
из новой библиотеки, старые блоки более не существуют в CFC
(библиотека вводится в диалоговом окне "Установки").
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3.9  [S7] Компиляция

Вы можете компилировать схему (другими словами все схемы папки схем) как
программу в целом или отдельную схему как тип блока.

3.9.1 [S7] Компиляция схемы как программы

В процессе компиляции схемы активного CPU преобразуются в машинный
код. В S7 используется Компилятор SCL.
Вы начинаете компиляцию с помощью команды меню "Chart > Compile >
Charts as Program..."  («Схема > Компиляция > Схема как программа») или

нажав иконку  на панели инструментов.

Связь
Для управления ресурсами CPU, используя функцию "Customize Compilation"
(«Настройка компилятора»), важно понимать связи, описанные ниже.
Структура, которую Вы конфигурируете в CFC, отображается в S7 как
машинные объекты FC и DB.
FC, необходимые для вызова блоков, обрабатываются в схеме CFC, согласно
сконфигурированной последовательности выполнения таким образом:

• Один FC для каждого OB

• Один FC для каждой рабочей группы

DB используются:
• Экземпляр DB создается для каждого экземпляра FB.
• Для хранения промежуточных результатов, например, из FC, создается

DB, внешний относительно CFC. Один DB требуется на один тип данных.
Когда достигается максимальная длина (4 кбайта), создается
дополнительный DB.

Что такое компиляция?
Когда Вы компилируете, то выбираете между двумя опциями:

• Range: Entire program (Диапазон: Программа в целом)
Если Вы компилируете всю программу, содержание папки схем
компилируется, несмотря на то, сделаны изменения или нет.

• Range: Changes (Диапазон: Изменения)
Если Вы компилируете изменения, компилируются только те объекты, в
которых произошли изменения. Изменениями считаются исключительно
изменения содержания (соединения, атрибуты блока, число входов и
т.д.), но не перемещения объектов внутри схемы. При выборе "только
изменений", время, затраченное на компиляцию, будет короче.

Замечание: Когда Вы компилируете изменения, проверяются только они.
Если Вы хотите проверить всю программу, выполните проверку
непротиворечивости.
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Необязательные функции до компиляции
Перед компиляцией Вы имеете возможность выбрать определенные опции,
которые будут выполняться перед запуском компиляции. Они включают в
себя следующие:

• Опция "Generate Module Drivers" ("Генерировать драйверы модулей")

Если установлена эта опция, драйверы модуля для существующих блоков
обработки сигналов генерируются и соединяются перед компиляцией.

• Опция "Update sampling time" ("Обновить время получения выборки")

Если блоки имеют входы для получения времени выборки (в блоках PCS
7, вход SAMPLE_T, атрибут "S7_sampletime = true"), время получения
выборки может быть обновлено.

Если Вы установили опцию "Обновить время получения выборки " (в
диалоге компиляции), система проверяет, какое прерывание цикла блока
OB инсталлировано перед компиляцией. Циклическое время OB
записывается на вход. Если блок инсталлирован в рабочую группу при
вычислении времени получения выборки, берется в расчет и отношение
циклов,

• Опция "Delete empty run-time groups" ("Удалить пустые рабочие группы")

Если установлена эта опция, пустые рабочие группы будут удалены
перед компиляцией.

Эти пустые группы  - результат копирования при ветвлении и слиянии
данных проекта.

• Опция: "Make Textual Interconnections" ("Выполнить текстовое
соединение")

Если установлена эта опция, все текстовые соединения перед
компиляцией будут замкнуты, если находится партнер по соединению;
другими словами,  они преобразуются в реальные соединения.

Замечание: Если опция не установлена или текстовое соединение не
может быть замкнуто, генерируется замещающая величина; то есть
используется величина параметра по умолчанию для этого типа блока.

Consistency Check (Проверка на непротиворечивость)
В процессе компиляции проверка на непротиворечивость выполняется
автоматически. Вы также можете запустить эту проверку вручную, например,
перед тем, как Вы переписываете старую программу CFC.

Подготовка к компиляции
С помощью команды меню "Options > Customize > Compilation..." (“Опции>
Назначения> Компиляция…») Вы вызываете диалоговое окно, в котором Вы
можете зарезервировать номера FC и DB для дальнейшего использования в
других приложениях. Эти области не используются CFC.
Для объяснения диалога и дополнительной информации об установках
обратитесь к интерактивной справке.
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После компиляции
Когда компиляция завершена (или прервана), будет показано диалоговое
окно "Протокол". Здесь протоколируются результаты компиляции, включая
предупреждения и ошибки. Основываясь на протоколе, Вы можете
проверить, была ли компиляция правильной, и можете распечатать протокол,
нажав кнопку "Print".
Вы также можете просмотреть протокол вновь, если требуется, распечатав ее
с помощью команды меню "Options > Logs..." («Опции> Протоколы»).

Замечание:
Компиляция программы в целом не обязательно предполагает загрузку
программы в целом. Если программа была загружена в CPU до компиляции,
можно загрузить только изменения.
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3.9.2 [S7] Компиляция схемы как типа блока

Вы можете создать типы блока из существующей схемы CFC, если хотите
использовать ее многократно. Вы можете назначать системные атрибуты
всем типам блоков.
Вы запускаете компиляцию с помощью команды меню "Chart > Compile >
Charts as Block Type..."  (“Схема > Компиляция > Схемы как тип блока…»).
Откроется диалоговое окно с двумя страницами.
На странице "General"  (Общее) Вы можете определить свойства типа блока
перед компиляцией (номер FB, символьное имя, имя (заголовок), семейство,
автор и версия (заголовок)) и определить целевую систему, в которой будет
использоваться блок (S7-300 или S7-400).
Вы можете оптимизировать код . Для оптимизации выберите между "local data
requirements" ("требования к локальным данным") и "download changes in
RUN" ("загрузка изменений в RUN"):

• Требования к локальным данным:
При этом типе оптимизации, изменения в схеме не увеличивают
требований, поскольку все временные переменные хранятся в
экземпляре DB (область VAR). Это приводит, однако, к изменениям в
структуре экземпляра DB, а , следовательно, и к изменениям метки
времени его интерфейса. В таком случае, не возможна загрузка в
интерактивном режиме.

• Загрузка изменений в RUN:
При этом типе оптимизации, если изменяется схема, временные
переменные хранятся в области VAR_TEMP, по мере возможности. По
мере возможности означает, что все промежуточные результаты в потоке
данных хранятся здесь. Только промежуточные результаты не из потока
данных (например, в замкнутом цикле) хранятся в области VAR
(экземпляр DB). Преимущества этого способа оптимизации в том, что не
все изменения приводят к изменениям метки времени интерфейса
экземпляра DB, так что в большинстве случаев изменения могут быть
загружены в интерактивном режиме. Один недостаток – увеличение
потребности памяти локальных данных.

Как опцию Вы можете также активировать защиту ноу-хау. Алгоритм блока
может быть изменен, когда имеется соответствующий исходный файл SCL.
На странице "Attributes" (“Атрибуты”) Вы можете ввести системные атрибуты
для типа блока (например, системный атрибут S7_blockview" величина "big").
Для более подробной информации смотрите интерактивную справку.
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3.10 Загрузка пользовательской программы в целевую
систему

Для тестирования и запуска пользовательской программы в CPU, ее нужно
туда загрузить.
Программа загружается в CPU, назначенное активной схеме.

Замечание:
Программу, созданную в CFC, Вы должны всегда загружать в целевую
систему из CFC, поскольку только функция загрузки гарантирует
совместимость данных конфигурации с данными AS.
Такая же функция используется, если Вы выбрали команду меню "AS >
Compile/Download Objects" ("AS > Компиляция/Загрузка Объекта" в SIMATIC
Manager.
С другой стороны, копирование блоков из "Offline Block Folder" ("Папки
блоков автономного режима") для того, чтобы вставить их в "Online Block
Folder" ("Папку блоков интерактивного режима"), не возможно

Загрузка
Для того, чтобы загрузить пользовательскую программу, выберите команду

меню "PLC > Download" ("PLC > Загрузка") (или нажмите кнопку    на
панели инструментов).
Затем появится диалоговое окно, в котором Вы выбираете тип загрузки и
запускаете дальнейший диалог для выбора опций.
Если в программе выполнены изменения, существенные для загрузки,
появится сообщение о том, что программа сначала должна быть
откомпилирована и Вас спросят, хотите ли Вы откомпилировать программу, а
затем загрузить.

Замечания:

• Компиляция программы в целом необязательно означает полную
загрузку. Если программа уже загружалась в CPU перед компиляцией,
можно загрузить только изменения.

• Если загрузка была прервана, загрузка изменений невозможна до
завершения полной загрузки. Причина: Блоки  удаляются из памяти CPU
перед загрузкой.

• Вы можете компилировать программу так часто, как Вы хотите (только
изменения или всю программу) без утери способности загрузить
изменения.
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[S7] Загрузка
Вы можете загрузить программу одним из двух способов: "Программу в
целом" или "Только изменения". Если выбрана "Программа в целом",
загрузятся все объекты программы; если - "Только изменения", Вы загрузите
только изменения, которые произошли со времени последней загрузки.
"Программа в целом" может быть загружена в режимах STOP или RUN-P. В
режиме RUN-P, CPU установится в STOP после запроса о согласии, и все
блоки будут очищены. После успешной загрузки, появится сообщение "Do you
want to restart the CPU?" ("Хотите ли Вы перезапустить CPU?"); ответьте “да”
для включения теплого перезапуска.
Вы можете загрузить "изменения" в режиме "RUN-P" CPU. Правильная
загрузка упорядочит ячейки, необходимые для данных. Пожалуйста, учтите,
что из-за возможных противоречий не существует абсолютной гарантии, что
CPU не перейдет в режим STOP
Система выполнит широкую проверку, что предотвратит загрузку, если
обнаружится ошибка. Также обратитесь к интерактивной справке CFC
"Загрузка Пользовательской программы в AS", раздел "System Support for
Avoiding Causes of CPU STOP".
Замечания:

• Загрузить изменения возможно Всегда, если

− Полная загрузка выполнена хотя бы раз.

− Вы загрузили структуру программы, которая была загружена ранее.

• Каждая загрузка включает в себя асинхронное уплотнение памяти CPU.
Это исключает предупреждения и сообщения об ошибках из-за
недостатка памяти при перезагрузках изменений. Уплотнение памяти
CPU при загрузке имеет другой эффект по сравнению с уплотнением
области номеров DB/FC. В последнем случае, загрузка изменений не
возможна.

• Компиляция программы в целом не требует загрузки в целом. Если
программа загружена в CPU до компиляции, можно загрузить только
изменения.

• Вы можете компилировать программу в целом или только изменения так
часто, как желаете, без утери возможности загрузить изменения.

• Если загрузка была прервана, оставшаяся часть может быть загружена в
новой попытке.

Замечание для H CPU: Если H CPU в режиме «solo», например, после
неисправности CPU и один из CPU неисправен, диалоговое окно покажет
доступ в интерактивном режиме. В этом диалоге Вы можете выбрать нужный
CPU. В резервном режиме этот диалог не появляется.
Замечание для системы F: Вы можете загрузить изменения для программы
с измененными F компонентами только после ввода пароля. Без  допуска
загрузка прерывается.

! Внимание!
Дополнительные причины остановки перечислены в интерактивной справке
под заголовком "Reasons for STOP when Downloading Changes Online".
Пожалуйста, прочитайте этот раздел перед тем, как Вы загрузите изменения
в интерактивном режиме на CPU в режиме "RUN-P".
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Опция: Включение пользовательских блоков данных
Если установлена эта опция (установка по умолчанию), когда Вы загружаете
изменения, блоки данных, которые находятся не в области CFC,
обрабатываются следующим образом:

• Они включены в загрузку, если метки времени различаются или
добавлены блоки данных.

• Они удаляются в CPU, если не существуют в программе S7.
Если Вы хотите, чтобы блоки данных пользователя игнорировались при
загрузке, деактивируйте эту опцию.
Учтите следующее:

• Если блок пользовательских данных существует в программе S7, но не
существует в CPU, загрузка будет прервана, появится сообщение об
ошибке.

• Если блок данных пользователя существует в CPU, но не существует в
программе S7, появится предупреждение; также будет в случае, если
блок данных пользователя в программе S7 отличается от блока в CPU.
Правильное выполнение программы – ответственность пользователя.

Сохранение установок без загрузки
Вы можете сохранить установки в диалоговом окне без запуска загрузки
(кнопка "Apply" “Применить”). Это может, например, быть полезным, если Вы
хотите использовать функцию "Compile and Download Objects"
(“Компилировать и загрузить Объекты”) в SIMATIC Manager.
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3.11  [S7] Выгрузка схем

Измененные данные
Вы можете сохранить (выгрузить) параметры всех схем CFC, содержащихся в
активной папке схем и те данных AS, которые были изменены (например,
ограничения управляющей величины, измененные оператором на OS).

Выгрузка
Вы запускаете выгрузку с помощью команды меню "Chart > Read Back...."
(“Схема > Выгрузить»).
Если Вы выбираете "Program of the CPU" ("Программа CPU"), как источник в
диалоговом окне "Read back" («Выгрузить»), программа из CPU (папка блоков
интерактивного режима) выгружается в папку схем с текущими параметрами.
Другим способом, Вы заранее выгружаете данные из CPU, используя
SIMATIC Manager (команда "AS > Upload Station"). При этом возникает
"Программа в автономном режиме" (Offline), которая используется как
источник в диалоговом окне "Read Back". Данные затем считываются из папки
блоков в автономном режиме (offline) и записываются в папку схем.
В ином случае, в диалоговом окне Вы можете выбрать, хотите ли Вы выгру-
зить все параметры входов блоков или только параметры, с системным
атрибутом для "управления и мониторинга оператором" (S7_m_c:='true').
После выгрузки производится автоматическая компиляция всей программы.
Это не заставляет, однако, загружать целую программу, ее можно загрузить с
сохранением режима RUN на CPU (только изменения).
При окончании выгрузки создается и отображается протокол. Вы можете
посмотреть протокол позже на странице ”Options > Logs > Read Back"
(“Опции> Протоколы > Выгрузка”). Помимо прочего, протокол показывает,
какие входы и выходы были выгружены и изменены и где появились
проблемы.

Замечания к выгрузке
• Входы и выходы, которым нельзя назначить величины параметров

(Атрибут: S7_param := 'false'), нельзя выгрузить.
• Величины входов FC и типы данных ANY, ARRAY, POINTER, UDT

игнорируются при выгрузке.
• Если величины изменены на AS и схема затем выгружена, эти изменен-

ные величины помечаются как загруженные, другими словами, если Вы
затем загружаете в CPU только изменения, эти величины не включаются.

• Определенные блоки могут исключаться из функции выгрузки (например,
блоки BATCH). В таком случае, тип блока имеет атрибут S7_read_back :=
'false'. Атрибут не может изменяться в экземпляре блока.

Замечание для H CPU: Если H CPU в режиме «solo», например, после
неисправности CPU и CPU неисправен, в диалоговом окне будет показан
доступ в интерактивном режиме. В этом диалоге Вы можете выбрать нужный
CPU. В режиме резервирования этот диалог не появляется.
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3.12 Раздельная разработка проекта

Всегда возможно выполнить раздельную разработку на одного проекта или
мультипроекта. Это позволяет конфигурировать, тестировать и вводить в
действие AS отдельно, для выполнения работ в разных точках или в сети PC
(режим множества пользователей).

Основные опции
• PC с сетевой структурой.

Проект находится на сервере, и несколько инженеров конфигурируют
определенные части проекта в одно время (AS, OS). Убедитесь, что
схемы AS или экраны на OS редактируются только одним PC (одним
пользователем) в одно время.

• Проекты внутри Мультипроекта.
Проекты мультипроекта хранятся централизованно на одном компьютере
и могут распределяться для редактирования на другие компьютеры. Для
редактирования отдельных станций, проекты передаются разработчикам
на их рабочие станции. Несколько проектов могут быть представлены на
одной рабочей станции компьютера одновременно.

После редактирования и слияния в мультипроект данные должны быть
синхронизированы с помощью системной поддержки (команда меню "File
> Multiproject > Adjust Projects" (“Файл > Мультипроект > Настройка
проектов”)) и нужно запустить соответствующие межпроектные функции
(например, компилятор OS). Эти функция должны выполняться позже,
когда конфигурация подготавливается к вводу в действие.

• Разделение и слияние данных проекта.
Вы можете разделить схемы программы S7 на несколько проектов
(ветвей). Разделение отдельных схем проекта и затем их слияние после
отдельного редактирования возможно в новой версии V6.0, которая
позволяет схемам структурироваться в последовательности выполнения.
Смотрите также: Модель последовательности выполнения CFC, Раздел 1
и Текстовые соединения при разделении и слиянии данных проекта,
Раздел 3.12.1.

Как разветвлять и сливать данные проекта
1. Скопируйте технологическую часть проекта (простая схема, несколько

схем) в другой проект.
Результат: Копия содержит текстовое соединение со всеми источниками,
которые были не скопированы.

2. Редактируйте скопированную часть отдельно (добавить, удалить,
изменить блоки и схемы).

3. Скопируйте отредактированную технологическую часть проекта обратно в
оригинальный проект.
Результат: Система сначала удалит схемы с одинаковыми именами в
оригинальном проекта. Сейчас текстовое соединение находится во всех
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схемах, которые ждут данные из удаленных схем. Система затем
копирует схему или схемы из другого проекта.

4. Замкните все открытые соединения с помощью команды меню "Options >
Make Textual interconnections" (“Опции > Выполнить Текстовые
соединения»).
Результат: соединение снова замкнуто во всех схемах другого проекта и в
оригинальном проекте, в котором текстовые соединения появились как
результат удаления схемы.

3.12.1 Текстовые соединения при разделении и слиянии данных
проекта

В связи с разделяющимися проектами и созданием отдельных
конфигурационных модулей, которые могут затем сливаться вместе, есть
некоторые аспекты, касающиеся текстовых соединений.

Последовательность и процедура

Когда Вы разделяете проект (известен как мастер проект), Вы копируете
часть папки схем в другую одну или несколько папок схемы, например, во
временный проект (ветка проекта) для разных разработчиков. Вообще, это
одна или более схем (но не все), которые передаются в различные проекты.
Соединения с другими схемами преобразуются в текстовые соединения на
входах и удаляются на выходах.

Когда Вы возвращаете редактированные схемы в мастер-проект
(копирование или перемещение), схемы с одинаковыми именами
обнаруживаются в мастер-проекте, то Вас запрашивают, хотите ли Вы
переписать существующий проект. Если Вы ответили "нет”, схема
вставляется как копия («не» с множеством схем), если Вы ответили “да”,
существующая схема переписывается ("все" с множеством схем). Перед тем,
как будет вставлена схема из ветвящегося проекта, она будет удалена из
мастер-проекта, но в отличие от обычного удаления (Del), как результат
текстового соединения.
С помощью команды меню "Options > Make Textual Interconnections" (“Опции >
Выполнить текстовые соединения»), Вы преобразуете их в реальные
соединения.

Вместо копирования схем в другие проекты, Вы можете переместить их
(вырезать и вставить). Преимущество копирования, однако, в том, что Вы
имеете функциональный мастер-проект до тех пор, пока не возвратитесь к
отредактированной схеме.
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Замечания:
• Когда соединение разрывается, никакой из партнеров соединения не

должен быть переименован, в ином случае текстовое соединение не
может быть замкнуто.

• Изменения  в схемах мастер-проекта отбрасываются, когда схемы с
одинаковыми именами возвращаются в мастер-проект из ветвящегося
проекта.

• Нежелательное соединение может появиться в мастер-проекте, если,
например, соединение между схемами было изменено в разветвленном
проекте и только одна схема была возвращена в мастер-проект.
Пример: В схеме CFC_A соединение с блоком в схеме CFC_B. Обе
схемы были скопированы в проекты ветвления и там отредактированы.
При редактировании соединение между схемами было удалено. Только
CFC_A была возвращена в мастер-проект. В результате в мастер-проекте
CFC появилось текстовое соединение, которое можно замкнуть.
Результат: Соединение, удаленное в проекте ветвления, возникло в
мастер-проекте.

• Текстовое соединение, созданное перед копированием/перемещением,
включается в целевой проект. Оно может быть конкретной частью отклика
(которые можно замкнуть) или символьной строкой (нужное соединение,
которое будет сконфигурировано в целевом проекте).
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4 Тестирование и ввод в эксплуатацию

Обзор
При вводе в эксплуатацию нового проекта редактор CFC обеспечивает Вас,
функциями тестирования, позволяющими Вам выполнять наблюдение и, при
необходимости, изменять входы и выходы блоков в контроллере.

4.1 Общие сведения

Редактор CFC имеет два рабочих режима: редактирования и тестовый.

• В режиме редактирования, Вы конфигурируете всю структуру
программного обеспечения CPU в автономном режиме (offline) (см. также
Главу 3 "Работа с редактором CFC").

• Когда Вы переключаетесь в тестовый режим, Вы можете наблюдать и
назначать параметры входам и выходам блоков; другими словами,
выполнять мониторинг  и модификацию переменных в интерактивном
режиме (online).

Во время тестирования, должно быть однозначное соответствие между
объектами в графическом представлении программы и физическими
адресами в CPU. По этой причине в тестовом режиме, в отличие от режима
редактирования, Вы не можете сделать изменения, влияющие на структуру
пользовательской программы (например, вставку или удаление блоков,
изменение подключения входов и выходов и т.д.).

Дополнительные функции тестирования
• Чтобы обеспечить Вам одновременное наблюдение в CPU некоторых

входов и выходов из различных блоков и схем, Вы можете отобрать эти
входы и выходы и отображать их постоянно обновляемые величины в
окне динамического отображения (dynamic display window).

• В дополнение к функциям непосредственного тестирования, есть также
группа функций, которые помогают Вам в подготовке к тестированию и
вводу в эксплуатацию, например, отображение информации о модуле,
установка времени дня и т.д.

Требования
Для использования функций тестирования и запуска, пользовательская
программа, созданная в редакторе CFC должна быть сначала без ошибок
откомпилирована и загружена в CPU.
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4.2 Функции до и во время тестирования

В дополнение к прямым функциям, имеются также некоторые функции,
которые окажутся полезными Вам для тестирования и ввода в эксплуатацию.
К ним относятся:

• Общие функции, такие как "Set Time and Date" ("Установка времени и
даты")

• Функции, поддерживающие Вас при системной диагностике и устранении
проблем, такие как, отображение режима или информации о модуле.

Эти функции описаны ниже.

4.2.1 Сравнение временных меток программ CPU

Вы можете отобразить временные метки загружаемой пользовательской
программы командой меню "PLC > Compare..." ("PLC > Сравнить...").

В диалоге будут показаны три временные метки:

• Последнее изменение, существенное для загрузки

• Последнее изменение программы на программаторе (offline)

• Последнее изменение программы в CPU (online)

Замечание: Временная метка "Last download-relevant change" ("Последнее
изменение, существенное для загрузки") изменяется также при присвоении
параметров входов и выходов блоков в тестовом режиме. Программа
пользователя, которую Вы загружаете в CPU, только в том случае идентична
программе CFC и машинному коду, когда идентичны все временные метки.
По меткам времени, которые могут сочетаться или не сочетаться, Вы можете
увидеть какие изменения были сделаны в пользовательской программе и
можете решить нужно ли Вам перекомпилировать и загрузить заново
программу.

4.2.2 Запуск и остановка программ CPU

Вы можете запустить или остановить программу CPU, выбрав команду меню
"PLC > Operating Mode..." ("PLC > Рабочий режим...") и нажав нужную кнопку
"Cold Restart"/"Hot Restart"/"Warm Restart" ("Холодный рестарт"/ "Горячий
рестарт"/"Теплый рестарт") или "STOP" ("Стоп") в диалоговом окне "CPU
program:stopping" (Программа CPU: останов").

Эта функция идентична соответствующей функции SIMATIC Manager. Эта
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager.
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4.2.3 Очистка/сброс CPU

Очистка или сброс средство полного удаления пользовательской программы
CPU и всех существующих соединений. CPU должен быть в режиме STOP.

Эта функция идентична соответствующей функции SIMATIC Manager. Эта
процедура описана в интерактивной помощи SIMATIC Manager.

Замечание: Если Вы загружаете пользовательскую программу полностью,
все блоки в CPU удаляются после подтверждения Вами запроса. В этом
случае, у Вас нет необходимости в предварительной очистке памяти CPU.
Если Вы очищаете память CPU, удаляется не только пользовательские
данные в CPU , но и соединения с модулями.

4.2.4 Установка времени и даты

Вы можете установить "Date and Time" ("Дата и время") на отдельном CPU,
выбрав команду меню "PLC > Set Time and Date..." ("PLC > Время и дата").

Эта функция идентична соответствующей функции SIMATIC Manager. Эта
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager.

4.2.5 Отображение информации о модулях

Вы можете отобразить текущее состояние модуля CPU командой меню "PLC
> Module Information..." (PLC > Информация о модуле).

Эта функция идентична соответствующей функции SIMATIC Manager. Эта
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager.
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4.3 Работа в тестовом режиме

Редактор CFC имеет тестовые функции, поддерживающие Вас при вводе в
эксплуатацию. Они позволяют вам наблюдать и воздействовать на
выполнение блоков в CPU и, если необходимо, изменять установки. Тестовый
режим соотносит CPU с текущей активной схемой.

Изменение цикла отладки
Входы и выходы, наблюдаемые в тестовом режиме, циклически обновляются
значениями переменных из CPU.

По умолчанию для обновления этих входов и выходов установлен цикл 2с.
Эта установка задается для CPU, иными словами,  она применима ко всем
схемам текущей папки схем.

Вы можете изменить время цикла в режимах редактирования или
тестирования следующим образом: открыть диалоговое окно "Debug > Test
Settings..." ("Отладка > Установки тестирования ), в котором Вы можете время
цикла для мониторинга.

Тестовые режимы
Тестирование возможно в одном из двух режимов:

• Рабочий режим

• Лабораторный режим

Вы можете выбрать режим для тестирования в режиме редактирования
используя  команды меню "Debug" ("Отладка"). Невозможно переключить
тестовые режимы, если Вы находитесь в режиме тестирования.

В рабочем режиме, коммуникации для интерактивного динамического
отображения блоков ограничены и вызывают ограниченную дополнительную
нагрузку на CP и шину. Когда активируется тестовый режим, все блоки
получают состояние "отладка отключена".

Лабораторный режим обеспечивает удобное и эффективное тестирование и
ввод в эксплуатацию. В лабораторном режиме, в отличие от рабочего
режима, коммуникации для интерактивного динамического отображения схем
CFC не ограничены. Когда активируется тестовый режим, все блоки получают
состояние "отладка включена". Вы можете наблюдать входы и выходы,
зарегистрированные для тестирования.

Активация тестового режима:
Выберите команду меню "Debug > Test Mode" ("Отладка > Тестовый режим")

или нажмите кнопку  в панели инструментов. Активируется тестовый
режим. Теперь Вы можете активировать функции из меню Debug (Отладка);
большинство функций из меню Edit (Редактирование) деактивируются .
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Если пользовательская программа в это время была изменена, когда Вы
переходите в тестовый режим, будет показано сообщение.

Деактивация тестового режима
Когда Вы переключаетесь из тестового режима в режим редактирования,
функции тестирования деактивируются и снова активируются функции
режима редактирования.

Вы выключаете тестовый режим, отжав на кнопку  в панели
инструментов или выбрав команду меню (сняв «галочку») "Debug > Test
Mode" ("Отладка > Тестовый режим").
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4.4 Мониторинг и назначение параметров входам и
выходам

Входы и выходы, которые зарегистрированы для тестирования, в тестовом
режиме обеспечиваются текущими значениями переменных от CPU, если для
этих входов и выходов активировано "watch" ("наблюдение").

Когда Вы активируете тестовый режим, активируется и функция "watch on"

("наблюдение включено")  для CFC в лабораторном режиме.

Это означает, что в тестовом режиме Вы можете отобразить изменение
переменных значений входов и выходов блоков и схем зарегистрированных
для отображения; другими словами, переменные циклически читаются  из
CPU и отображаются. Вы можете изменить настройки для этого
динамического отображения и параметры входов и выходов в тестовом
режиме.

В рабочем режиме активирована функция "watch off" ("наблюдение

выключено")  .  Это значит, что Вы должны сначала выбрать в схеме
блоки для динамического отображения, которые Вы хотите наблюдать; и
после этого выбрать "watch on" ("включить наблюдение").
Если, с другой стороны, возникает перегрузка, Вы можете удалить отдельные
блоки и схемы из списка наблюдения  (выбрать блок или схему и затем
команду меню "watch off"  ("выключить наблюдение").

Предупреждение: Если наблюдение деактивировано, и Вы выбрали вход

или выход для его регистрации для тестирования с кнопкой  ,
наблюдение активируется для этого и для всех остальных входов и выходов
этого блока, зарегистрированных ранее для тестирования.

Когда Вы активируете тестовый режим, соединения с CPU устанавливаются
для всех входов и выходов, перечисленных в окне динамического
отображения. Вы активируете функцию "watch" ("наблюдение") с проверкой
метки в колонке "Watch" ("наблюдение") для всех отдельных входов и
выходов.

Замечание:

• Вы можете наблюдать входы и выходы блока, которые не хранятся в
DB. Это возможно, например, для неподключенных входов FC или
BOP и для выходов типов STRING, DATE_AND_TIME, ANY.

• В тестовом режиме, если вход EN=0, функциональные блоки (FB) не
показывают для подключенных входов переменные от подключенных
источников. Вместо этого как подключенный вход показывается
величина, с которой блок был выполнен последний раз. Напомним, что
переменные на подключенных входах могут изменяться, только когда
вход  EN=1. FC и BOP, с другой стороны, всегда показывают значение
подключенных источников.
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4.4.1 Входы и выходы блоков и схем в окне схемы

Добавление и удаление входов и выходов в списке отладки
В режиме редактирования или в тестовом режиме (рабочем или лаборатор-
ном), Вы можете зарегистрировать для тестирования отдельные входы и
выходы блока или схемы, выбрав вход или выход и вызвав команду меню
"Debug > Inputs/Outputs > Add to Watch List" ("Отладка > Входы/выходы >

Добавить в список наблюдения") или нажав кнопку  в панели
инструментов.

В тестовом режиме, наблюдение также активируется одновременно; другими
словами, входы и выходы показанные на желтом фоне и показывают их
текущее значение. Если наблюдение было ранее деактивировано для этих
блоков и схем, функция наблюдения активируется для всех других входов и
выходов, которые ранее были добавлены в список наблюдения.

Вы можете удалить входы и выходы из списка наблюдения, выбрав вход и
выход и затем подав команду меню "Test > Remove from Watch List" ("Тест >

Удалить из списка наблюдения") или нажав на кнопку  в панели
инструментов.

Альтернатива: Вы можете также выбрать или отменить выбор входов или
выходов блоков и схем для тестирования в режиме редактирования
отобразив "Object Properties" ("Свойства объекта") для выбранного блока и
выбрав или отменить выбор входа или выхода в колонке "Watched"
("Наблюдаемый") на странице "Inputs/Outputs" ("Входы/выходы").
Замечание: Вы должны избегать наблюдения излишне большого числа
входов и выходов одновременно, или, иными словами, слишком большой
коммуникационной нагрузки на шину и CPU. Если нагрузка слишком велика
(например >500 при цикле наблюдения 1 с), это может обнаружить бит
работоспособности; переменные на входах выходах в этом случае
отмечаются, как временно "нарушенные".

Активирование и деактивирование наблюдения входов и выходов
Вы активируете наблюдение (отображение текущих значений на входах и
выходах) входов и выходов блоков и схем в списке наблюдения следующим
образом:

• автоматически активацией лабораторного тестового режима.

• командой меню "Debug > Watch On" ("Отладка > Включить наблюдение")

или кнопкой  в панели инструментов. В лабораторном режиме, эта
функция применяется ко всем блокам; в рабочем режиме только к
блокам, предварительно выбранным в схеме.

• Выбором команды меню "Debug > Watch Off" ("Отладка > Наблюдение

выключить") или нажатием на кнопку  в панели инструментов, Вы
можете прекратить наблюдение; другими словами, переменные на входах
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и выходах более не обновляются.
В лабораторном режиме это применимо ко всем блокам; в рабочем
режиме только к блокам, выбранным в схеме.

Все переменные на выходах и входах активируются в списке наблюдения и
обновляются в цикле мониторинга.

Отображение переменных
Переменные отображаются вблизи входов и выходов в соответствии с их
типом данных. Они показаны на экране на цветном фоне.

• Черные звезды на желтом  = величины, при изменении для
динамического отображения

• Черные цифры на желтом = переменные читаются из CPU

• #### на красном фоне = когда динамические переменные от CPU не
поступают (проблемы)

Установка значений входов и выходов
Если активен тестовый режим, Вы можете модифицировать значения всех
неподключенных входов.
Перед тем, как модифицированные переменные будут приняты CPU,
проверяется их правильность.

Пожалуйста, заметьте, что параметры, модифицируемые в тестовом режиме,
всегда включаются в управление данными CFC.
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4.5 Динамическое отображение

В этом тестовом режиме, переменные входов и выходов блоков и схем могут
динамически отображаться в отдельном окне. Это возможно для
элементарных типов данных (BO, W, R, ...) и для элементов структур.

Окно динамического отображения
Окно динамического отображения может открываться и располагаться в окне
редактора CFC вдоль любого окна схемы. Вы можете настроить размер окна.
Имеется только одно окно динамического отображения без отдельного меню
для всех схем CPU. Когда окно закрывается (или когда выходим из редактора
CFC) содержание сохраняется (только статическое содержание, не
переменные) и при новой загрузке Вы открываете это окно.

Окно динамического отображения активируется и деактивируется "View >
Dynamic Display" ("Вид >  Динамическое отображение"). Оно разделяется на
колонки (Вы можете изменять их ширину) со следующими заголовками и
информацией:

• Status (Состояние):
В этой колонке показываются сообщения о состоянии (например, ошибка
CPU, ошибка переменной, ....).

• Watch (Наблюдение)
В этом боксе выбора, Вы определяете должен ли, или нет наблюдаться
данный вход или выход; другими словами, должна или нет динамически
отображаться величина переменной.

• Chart (Схема) показывает имя схемы. Если это вложенная схема,
показываются также имена схем верхнего уровня (предков) (например,
ToptChart\Sim_reg ).

• Block (Блок) показывает имя блока CFC или вложенной схемы
(например, switch, controller, ...)

• I/O (Входы/выходы)  показывает имя входов и выходов (например, LMN,
IN1, ...)

• Value (Величина) показывает текущую величину входа или выхода блока,
прочитанную из CPU (если отмечен бокс выбора в колонке "Watch"
(Наблюдение)). Если при этом возникают проблемы, показывается
значение ####.

• Unit (Единица измерения) показывает текст для выбранной физической
величины (если она существует) (например, s, %, ...)

• Comment (Комментарий) показывает комментарий для входов и выходов
(если он существует).

Совет: Если текст не может отобразиться полностью, из-за недостаточной
ширины колонки, Вы можете увидеть полный текст на экране подсказки при
установке указателя мыши на данное поле.
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4.5.1 Входы и выходы в окне динамического отображения

Вставка входов и выходов
Вы можете вставить входы и выходы в динамическое отображение в режимах
редактирования и тестирования. Это делается аналогично вставке и
удалению входов и выходов блоков и схем в окне схемы.

Вы можете включить входы и выходы открытой схемы в окно динамического
отображения следующим способом:
• Выбрать нужный вход или выход блока и затем команду "Debug >

Inputs/Outputs > Include in Dynamic Display" ("Отладка > Входы/Выходы >
Включить в динамическое отображение").

• Перетащить мышью требуемый вход или выход в окно динамического
отображения.

Входы и выходы блока типа STRUCT: До вставки входа или выхода в
динамическое отображение, открывается диалоговое окно, в котором Вы
можете выбрать элементы структуры для отображения их значений.

Если Вы хотите включить в динамическое отображение все входы и
выходы блока или вложенной схемы, Вы должны выбрать блок или схему и
перетащить их в окно динамического отображения. Исключение: входы и
выходы типа данных STRUCT не будут включены.

Удаление входов и выходов
Выберите соответствующую строку в динамическом отображении и удалите
ее (или их) командой "Edit > Delete" ("Редактировать > Удалить") или нажав на
клавиатуре клавишу DEL.

Отладка переменных
Вы можете наблюдать величины на входах и выходах блоков и схем без
открытия соответствующих схем.
Величина отображается динамически (на желтом фоне) в соответствии с
выбранным циклом наблюдения если:
• Активирован тестовый режим,
• Входы и выходы (или элементы структуры) разрешены для наблюдения

(выбором в колонке "Watch" ("Наблюдение"))
• Установлено соединение с CPU.

Если с величиной связана ошибка, она отображается как #### и величины на
входах и выходах, которые не могут наблюдаться, показываются как  -----.

Открытие схемы
Если Вы выбираете строку в динамическом отображении, Вы можете перейти
к тому месту, где расположен соответствующий данной строке вход или
выход. Командой меню "Edit > Go To > Chart" ("Редактировать > Перейти >
Схема") открывается соответствующая схема и выделяется вход или выход.
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5 Документирование

Обзор
Эта глава обзорно знакомит Вас с созданием исчерпывающей документации
для Вашей структуры конфигурации CFC. Она включает в себя:
• Схему
• Справочные данные по схеме
• Протоколы

5.1 Распечатка схемы

Используя функцию печати, Вы можете распечатать в CFC текущую схему.
Вы должны установить требуемый шаблон ("Chart > Page Setup..." ("Схема >
Настройка страницы")) и предварительно просмотреть схему ("Chart > Print
Preview" ("Схема > Предварительный просмотр страницы")), если Вы хотите
ее распечатать.

Распечатка активной схемы
Командой меню "Chart > Print" ("Схема > Печать") Вы распечатываете
активную схему на принтере, установленном по умолчанию.

Открывается диалоговое окно, в котором Вы можете выбрать, что Вы хотите
печатать, например "текущий лист (sheet):текущий раздел схемы: все
разделы схемы".

Если схема имеет входы или выходы, Вы должны решить, печатать ли схему
с входами и выходами или без них. Входы и выходы схемы распечатаются на
отдельной странице в виде таблицы (содержит всю существенную
информацию, такую как тип данных, начальное значение, невидимость, ...).
Если входов и выходов слишком много для одной страницы,
распечатываются и все последующие страницы.

Когда Вы печатаете из SIMATIC Manager, схемы нижнего уровня, другими
словами,  схемы, вложенные в схему базового уровня распечатываются
также (по умолчанию). Когда Вы сбрасываете бокс выбора Include nested
Charts (Включая вложенные схемы) (в SIMATIC Manager), Вы можете
отменить вывод на печать этих схем.

Кнопкой "Options" в диалоговом окне, Вы можете отобразить дальнейшие
свойства принтера. Независимо от текущего шаблона схемы (может быть
установлен через "Options > Customize > Layout..." ("Выбор > Настройки >
Шаблон")), в этом диалоге Вы можете определить должны ли выводиться на
печать адреса, входы и выходы, и информация из заголовков блоков.
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5.1.1 Нижние колонтитулы

Печать в DOCPRO
С дополнительным пакетом DOCPRO Вы можете распечатать схему (или
схемы) CFC вместе с колонтитулами data. В колонтитулах делаются различия
между глобальными и локальными данными схемы.

Вы можете ввести глобальные данные проекта, используя  DOCPRO или
SIMATIC Manager; локальные данные, заданные для схемы, должны
вводиться в редакторе CFC. Обратите внимание, что данные, заданные для
схемы, перекрывают введенные глобальные данные для отдельных схем.

Вы можете также ввести данные, заданные для схемы даже, если Вы не
имеете установленного дополнительного пакета DOCPRO. Эти данные
сохраняются и могут быть напечатаны позднее, когда DOCPRO будет
доступен для заданий печати.

Колонтитулы включают фиксированные поля с непрерывной нумерацией
страниц задания на печать. Для заданий превышающих 99 страниц,
показывается как последовательный, так и глобальный номер; например,
2/14.
Если в заданной обложке более 99 страниц, глобальный номер страницы не
отображается, однако номер страницы следует за "+" для указания, что
следует большее число страниц; например 1+ .... 7+ и т.д.
За номером последней страницы следует "-"; например, 127-.

В глобальных колонтитулах Вы можете ввести ключевые слова,  которые
заменяются текущим текстом при печати. Текущие тексты получаются из
свойств схемы (Object Properties) (например, комментарий схемы, дата
создания и т.д.). Вы можете использовать ключевые слова, а их значения
разъяснены в интерактивной помощи для CFC.

Колонтитулы для заданной схемы

Командой меню "Chart > Footers..." ("Схема > Колонтитулы"), Вы выводите
диалоговое окно с несколькими страницами: от "Part 1" ("Часть 1") до "Part 4"
(Часть 4") и "Свободные поля".

Здесь Вы делаете вводы в активных полях, таких как:
Type of document Тип документа), Date created (Дата создания), Document
number (Номер документа), Date  modified (Дата изменения), Free texts
(Свободный текст) и т.д.
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5.2 Справочные данные схемы

Обзор
Командой меню "Options > Chart Reference Data..." («Опции > Справочные

данные схемы…») или нажав на кнопку  в панели инструментов,  Вы
можете запустить и отображение, и печать различной информации в виде
списка или как древовидную структуру (см. 2.2.1).

Этот список помогает Вам  при проверке структуры Вашей конфигурации.

Различные версии

Список создается системой и не обновляется автоматически. Каждый список
содержит информацию о состоянии проекта на момент создания списка.
Различные версии этого списка могут быть открыты одновременно.

Если необходимо Вы можете обновить список, используя команду меню "View
> Update" («Вид > Обновить») или клавишу "F5".

Дальнейшие возможности

Вы можете сгенерировать списки не только для проекта редактируемого в
CFC, но имеете доступ ко всем другим проектам CFC. Это позволяет Вам
сравнить различные проекты. Списки различных проектов могут быть
открыты одновременно.

Командой меню "Edit > Find..." («Редактировать > Найти»), Вы можете найти
термы (текстовые строки) в активном окне. Если терм найден, показывается
его расположение.
Если дважды щелкнуть имя в первой колонке, Вы можете открыть схему, в
которой расположена указанная точка. Соответствующий объект будет
выделен.

Документация

Наряду с распечаткой схем, справочные данные обеспечивают Вас полной
документацией о сконфигурированной Вами структуре.

Экспорт

Вы можете сохранить сгенерированный список как файл в формате CSV
(например, для использования в EXCEL) командой меню "Reference Data >
Create Export File..." («Справочные данные > Экспортировать файл»).
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5.2.1 Список справочных данных по схеме

Вы можете отобразить на экране или распечатать следующие справочные
данные:
• Run Sequence (Последовательность исполнения)   

Графическое представление всей последовательности выполнения
выполнения.

• Cross-References Chart Element -> Address (Перекрестные ссылки
элементов схемы > Адреса)
Список включает все глобальные адреса, используемые в проекте с
элементами которые обращаются к ним.

• Cross-References SFC -> Chart Element (Перекрестные ссылки SFC >
Элементы схемы)
Доступы всех схем SFC к входам и выходам элементов схем CFC.

• Cross-References Chart Element -> Run-Time Group (Перекрестные
ссылки элементов схемы > Группы исполнения)
Список включает доступы ко всем рабочим группам всех схем CFC и SFC.

• Block Types
Список включает используемые типы блоков и их расположение (схема
CFC).

• S7 Resource Allocation (Назначение ресурсов S7)
Список включает соответствие между объектами конфигурации CFC и
ресурсами S7.

• Local Data (Локальные данные)
Список включает все OB в программе с вычисленными потребностями в
локальных данных и размере локальных данных отдельных классов
приоритетов, сконфигурированных в проекте и реально существующих на
CPU.

• Block Call Hierarchy (Иерархия вызова блоков)
Графическое представление иерархии вызовов всех блоков программы.

• Textual Interconnections (Текстовые соединения)
Этот список включает все текстовые соединения (путь, указывающий на
цель соединения) с именем схемы и элемента – источников соединения.

• Statistics (Статистика)
Графическое представление числа всех объектов CFC и SFC и
используемых  ресурсов S7, а также временные метки текущей
программы и объектов проекта.

Для детального описания списков и значения колонок обратитесь к
интерактивной справке по CFC.

5.3 Протоколы

Протоколы не принадлежат к документации сконфигурированной структуры,
но могут обеспечить важную информацию в процессе проектирования и
пробных пусков, если происходят ошибки.

Для дальнейшей информации о протоколах, справьтесь в интерактивной
справке в разделе "Logs" («Протоколы»).
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A Технические Спецификации

A.1 [S7] Технические спецификации

Требования к аппаратному обеспечению

• SIMATIC PG или PC
• Pentium
• RAM не менее 128 Мбайт

(рекомендуем 256 Мбайт или больше)
• Винчестер (свободная область) около 500 Мбайт (менее памяти RAM)
• Графическая карта VGA 640 x 480

(рекомендуем: SVGA 1024 x 768 или следующие версии)
• Соединение MPI для интерактивной работы
• SIMATIC S7-300, S7-400

Требования к программному обеспечению

• Microsoft Windows 95 (с Сервисным пакетом 1)
или

• Microsoft Windows 98
или

• Microsoft Windows NT (с Сервисным пакетом 3)
или

• Microsoft Windows ME
или

• Microsoft Windows 2000
или

• Microsoft Windows XP

• STEP 7
• Компилятор SCL
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A.2 Длины полей/имен и договоренности

 Объект  Длина  Примечания
Схема 22 Имя не должно содержать следующие символы:

 \  .  "  %
Комментарии к схеме 255 Доступны все символы ANSI .
Группа выполнения 22 Те же символы что и для "схемы"
Задача 22 Те же символы что и для "схемы"
Тип блока 8 Определяется STEP 7.
Комментарии
для экземпляра блока

80 Доступны все символы ANSI.

Имя параметра 24 Определяется STEP 7.
Первый символ не может быть числом (0 - 9).

Комментарии параметра 80 Доступны все символы  ANSI.
Имя экземпляра 16 Имя не должно содержать следующие символы:

 \  .  "  %
Глобальные переменные 24 Символы определяются редактором. Разрешается

использовать любые, в том числе пробелы и специальные
символы за исключением   ".
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A.3 [S7] Типы данных

 Сокр.  Ключевое слово  Значение  Биты
A ANY Указатель к элементу данных 80
BO BOOL Логическая переменная 1
BY BYTE Последовательность из 8 бит 8
C CHAR Простой символ 8
CR COUNTER Номер счетчика S7 16
D DATE Дата 16
DB BLOCK_DB Номер DB 16
DI DINT Двойное целое 32
DT DATE_AND_TIME или DT Дата и время 64
DW DWORD Последовательность из 32 бит 32
FB BLOCK_FB Номер FB 16
FC BLOCK_FC Номер FC 16
I INT Целое 16
P POINTER Указатель к области памяти 48
R REAL Число с плавающей точкой 32
S STRING Строка произвольной длины 256 байт
SD BLOCK_SDB Номер SDB 16
SN STRING[n] Текстовая строка с максимум n символами, 1 < n

< 253
ST STRUCT Круглые скобки для элементарных типов данных

и других структур (глубина вложенности: 8)
T TIME_OF_DAY или TOD Время дня 32
TI TIME Интервл времени 32
TR TIMER Номер таймера S7 16
T5 S5TIME Длительность в формате S5 16
W WORD Последовательность из 16 бит 16

Для более детального описания типов данных пользуйтесь интерактивной
справкой.
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B Список сокращений

BOP Основные операции

C / C++ Язык программирования высокого уровня

CFC Непрерывные функциональные схемы

CPU Процессор

DB Блок данных

ES Инженерная система

FB Функциональный блок

FC Функция

HID Наивысший уровень обозначения

IEA  Ассистент импорта/экспорта

LAD Контактная схема

OB Организационный блок

OCM Управление и мониторинг оператором (WinCC)

OS Операторская станция
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PC Персональный компьютер

PCS 7 Система управления процессом (SIMATIC)

PG Программирующее устройство

PH Иерархия производства

PLC Программируемый (логический) контроллер

SFB Системный функциональный блок

SFC Последовательные функциональные схемы

SINEC Сетевая архитектура Siemens

STEP 7        Оболочка разработки программного обеспечения для SIMATIC S7/ M7

STL Список команд
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Словарь

А

Абсолютная адресация
Когда данные адресуются абсолютно, адрес используется для доступа
переменной, с которой выполняется операция. Пример: Адрес Q4.0
определяет бит 0 в 4 байте области отображения выходов (PIQ).

Адрес
Адрес - обозначение расположения данных области, содержащей данные,
например: вход I12.1; слово меркеров MW25; блок данных DB3. Адрес в STEP
7 - часть инструкции и сообщает процессору, что он должен использовать в
качестве операнда. Адрес может быть определен в абсолютной и
символической форме
В SFC адрес - часть инструкции (шаг) или условия (переход).

Ассистент экспорта и импорта (IEA)
Составная часть программного обеспечения PCS 7 для  обработки моделей и
типов и типов тегов процесса.

Атрибут разрешения
Атрибут разрешения - атрибут стадии исполнения. Он включает или
выключает, например, группу выполнения. Когда он деактивирован (FALSE),
группа не выполняется, независимо от других условий.

Атрибут разрешения может устанавливаться динамически. В этом случае,
выходная величина блока CFC или инструкция в SFC определяют должна ли
активироваться группа выполнения или схема SFC.

Атрибуты выполнения
Каждая рабочая группа имеет атрибуты выполнения, управляющий ее
активацией. Группа передает этот атрибут всем установленным в ней блокам
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Б

Базовые операции
Базовые операции (BOP) постоянные объекты системы, реализующие
простые функции, такие как AND, OR и т.д. Они представляются в CFC как
блоки.

Библиотека блоков
Папка для объектов, которые могут использоваться многократно. Библиотека
не связана с проектом. Блоки в библиотеках отсортированы согласно
определенным критериям (семейства блоков, алфавитный порядок и т.д.).

Блок:
Блоки - отдельные части пользовательской программы,  которые отличаются
функциями, структурой или назначением.

CFC работает с готовыми типами блоков которые размещаются на схеме
CFC. Когда блок определенного типа вставляется в схему, создается
экземпляр блока. Этот экземпляр блока и его графическое представление
являются блоком в смысле CFC.

При перемещении их в произвольной позиции на листе, они снова становятся
обычными блоками, включая их предыдущие подключения.

Блок данных (DB)
Блок данных - область данных пользовательской программы, хранящая
пользовательские данные. Имеются глобальные блоки данных, доступ к
которым возможен из всех логических блоков и экземплярные блоки дынных,
которые связаны с конкретными вызовами FB. В отличие от других блоков,
DB не содержат команд.

В

Верхняя схема
Схема CFC, которая не вставлена в другую схему и может быть отображена в
SIMATIC Manager ( � вложенные схемы).
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Вложенная схема
Схема CFC, которая вставлена в другую схему CFC (вложенная или верхняя
схема). Вложенные схемы не показываются в SIMATIC Manager.

Внешний вид
Внешний вид это графическое представление схемы CFC как блока (с
интерфейсом) позволяющее выполнить внешнее подключение входов и
выходов. Внешний вид – стандартный интерфейс, производный от системы
выполнения SFC.

Внешний вид схемы SFC может подключаться к любому объекту (блокам
CFC, вложенным схемам, группам выполнения, текстовым ссылкам,
глобальным адресам). Это допускает включить схему SFC для управления
непосредственно в CFC.

Внешний вид отображается в отдельном окне CFC. Другие объекты не могут
отображаться в этом окне. Подключение к другим объектам CFC реализуются
только через панель листа.

Время цикла
Время цикла - время требуемое CPU для однократного выполнения
пользовательской программы

Входы и выходы блока
Вход или выход блока или схемы. Входы и выходы совпадающего типа
подключаются друг к другу и глобальным адресам.

Вход блока
Вход блока может подключаться к выходу блока или к адресу того же типа
данных или может иметь назначенный ему параметр

Выход блока
Выход блока может быть подключен к входу блока и адресу
соответствующего типа данных
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Г

Глобальный адрес
Глобальные адреса – это объекты, которые доступны в любом логическом
блоке (FC, FB, OB). Они включают меркеры (M), входы (I), выходы (Q),
таймеры (T), счетчики (C), и элементы блоков данных (DB). Для доступа к
глобальным адресам, используется абсолютный адрес или символ.

Глобальный блок данных
Это блок данных, который доступен из всех блоков программы. Каждый
интерфейс блока CFC может читать глобальные данные из блока или писать
данные в блок.

Д

Динамическое отображение
При динамическом отображении, входные и выходные величины блоков в
схеме CFC или адресованные переменные в схеме  SFC обновляются от CPU
в тестовом режиме.

Доступ
Элементы SFC или входы и выходы блоков имеют доступ к адресам, схемам,
входам и выходам блоков или группам исполнения. Следует различать
доступ для записи и чтения.

З

Заголовок блока
Верхняя часть блока при его отображении в CFC. Он содержит имя и
назначение задачи - привязка задачи (свойства выполнения).

Задача
Задачи – форма интерфейса между операционной системой CPU и
пользовательской программой. Порядок выполнения пользовательской
программы определен в задачах. В M7, задачи размещаются в RMOS
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В S7 задачам соответствуют организационные блоки (OB).

И

Идентификатор переменной
Символическое обозначение (текст) для определения значения входов и
выходов блоков типов BOOL, BYTE, INT, DINT, WORD и DWORD.

Изменения, существенные для загрузки
Изменения схем CFC/SFC (типа SFC) являются существенными для загрузки,
когда они являются причиной изменения пользовательской программы в CPU
(например, изменения подключения). Изменения, которые не существенны
для загрузки включают в себя, например, изменение положения блока или
комментария.

Изображение блока
Графическое представление большей части существенной информации
технологических блоков PLC, которые могут управляться и наблюдаться
оператором. Изображение блока обычно размещается на обзорном экране
OS. Через изображение блока может быть вызвана соответствующая панель
управления.

Иерархия предприятия (PH)
Иерархия, организованная в соответствии с технологическими аспектами.

Иконка
В своем графическом представлении заголовка блок может иметь иконку
вместо текстового имени типа (или назначенного FB/FC). Эта иконка может,
например, быть стандартной иконкой для контроллера, ограничителя,
элемента NAND и т.д..

Интерфейс
Интерфейс состоит из входов и выходов блоков или схем, которые могут
подключаться или снабжаться параметрами.
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К

Каталог
Окно в CFC которое позволяет переключаться между каталогами блоков,
схем, библиотек и неразмещенными блоками (если они существуют).
Блоки, схемы, и текстовые элементы могут быть вставлены из каталога в
схему.

Категория блоков
Категория блоков обозначает различные формы блока. Категории блоков
включают, например, блоки данных (DB), функциональные блоки (FB) и
функции (FC).

Класс сообщений
The message class determines the properties of a message. In SIMATIC PCS 7,
there are the following message classes: alarm, warning, tolerance, PLC and OS
process control message, process message, operator prompt, and operator
message.

Компонентное представление (Component view)
Представление проекта в SIMATIC Manager, ориентированное на аппаратуру.
Проект показан в виде компонентов системы автоматизации (станция,
модуль, программа ... );
альтернатива к технологическому представлению (Plant View).

Коннектор
Указатель соединения блока с ссылкой на вход или выход к которому он
подключен. Коннекторы используются, когда на листе больше нет места для
изображения линий соединения, поскольку он заполнен. Коннекторы
допускают комплексные структуры CFC, включая полное указание перехода
на другие листы.

Конфигурирование сообщения
Создание сообщения с его атрибутами и текстом. Сообщения можно
конфигурировать в CFC и SFC
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Л

Лист
Часть раздела схемы. A � раздел схемы состоит из 6 листов. Лист
предоставляет рабочее пространство (с панелями листа), в котором
размещаются блоки, назначаются параметры и соединения

Локальные данные
Локальные данные это данные с логическим блоком, которые перечислены в
его декларационной части или в объявлениях переменных.

М

Мастер-проект
Мастер-проект это проект, который может быть разделен на отдельные
проекты (ветвление проекта) для более эффективного проектирования.
После редактирования части возвращаются в исходный мастер-проект.

О

Обзор схемы
Обзор схемы CFC или раздела схемы с их 6 листами.

Окно динамического отображения
Окно в CFC для наблюдения отдельных входов и выходов блоков в CPU.

Операционная система
Общий термин для всех функций управления и наблюдения за
пользовательской программой, распределения ресурсов между отдельными
программами и поддержанию рабочих режимов в связи с оборудованием
(например, операционная система MS-WINDOWS, операционная систем а
реального времени M7 RMOS32).
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Организационный блок (OB)
Организационный блок – форма интерфейса между операционной системой
CPU и пользовательской программой. Порядок выполнения пользовательской
программы определяется организационными блоками.

В S7 задачи обозначаются как организационные блоки (OB).

Отображение процесса
Зарезервированные области в ОЗУ CPU. В них вводятся состояния сигналов
на входах и выходах модулей

Отношение циклов
Атрибут выполнения. Он определяет, сколько циклов задачи (OB) приходится
на один цикл выполнения рабочей группы. См. также – смещение по фазе.

П

Панель листа
Правое и левое поля схемы CFC. Панель листа содержит:

• ссылки на подключенные объекты (интерфейсы блоков и схем, адреса
рабочие группы) которые находятся не на этом активном листе

• ссылочный номер соединения когда соединительная линия не может
быть размещена на листе из=за его заполненности.

Папка схем
Папка в структуре проекта, содержащая схемы пользовательской программы.

Параметр
Параметр это

1. Величина на входе или выходе блока или схемы CFC.
2. Переменная логического блока S7 (действительный или формальный

параметр)
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Перекрывающийся блок
Перекрывающиеся блоки это которые не могут быть полностью поместиться
на свободной позиции листа. Они полностью или частично перекрываются
другими объектами. Перекрывающиеся блоки показываются в схеме с
полным размером, но без входов и выходов и подсвечены серым.
Существующие входы и выходы не видимы в этом представлении, хотя и
существуют.

То же применимо и к вложенным схемам

Переменная процесса
Переменная процесса – нейтральный объект с точки зрения ресурсов. Она
используется для соединения конфигурации PLC (STEP 7, CFC ...) с
конфигурацией OS (WinCC). Она содержит информацию о расположении при
выполнении (например, сетевой адрес и область памяти в PLC), а также
информацию о специфических свойствах, существенных для OS.

Перетаскивание
Используя мышь, Вы можете перемещать, копировать и вставлять объекты.

Последовательность:

1. Выберите соответствующий объект щелкнув на нем используя лассо

2. Поместите курсор мыши на объект, нажмите левую кнопку мыши и
удерживайте ее нажатой

3. Для копирования, удерживайте нажатой клавишу CTRL  - курсор мыши
получит дополнительную иконку "+"

4. Переместите мышь на требуемую позицию и отпустите кнопку мыши,
объект будет вставлен.

Проверка согласованности
Проверка согласованности типов блоков, общих адресов и т.д. папки схем.

Программа
Общий термин для программ S7 и M7.

Программа S7
Папка для таблицы символов, блоков, исходных файлов и схем для
программируемых модулей S7.
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Программируемый контроллер
Программируемый контроллер (PLC) - контроллер SIMATIC S7, компактное
устройство (PLC с встроенной системой управления оператором) SIMATIC
C7, или компьютер SIMATIC M7.

Проект
Папка для всех решений автоматизации, независимо от числа станций или
модулей, в том числе сетевых.

Процессное представление
Представление в SIMATIC Manager. В процессном представлении, все
данные основного управления процессом могут представляться в виде,
ориентированном на процесс управления

Р

Рабочая группа
Рабочая группа используется для организации задач. Блоки устанавливаются
в рабочую группу в последовательности выполнения. Рабочая группа может
отдельно активироваться и деактивироваться. Если рабочая группа
деактивирована, деактивированы и все содержащиеся в ней блоки.

Раздел схемы
Часть схемы CFC. Схема CFC подразделяется максимум на 26 разделов
(именуемых от A до Z), каждый с 6 листами.

Режим редактирования:
(Альтернатива - тестовый режим) В CFC могут вставляться, копироваться,
перемещаться, удаляться блоки, назначаться параметры и соединения.

Ресурсы
Это множество объектов (FB, FC, DB, OB, меркеры, счетчики, таймеры и т.д.)
доступных при конфигурировании и назначении параметров схем CFC и SFC.
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С

Свойства выполнения
Чвойства выполнения определяют включение блока в определенную
последовательсность выполнения в структуре PLC. Эти свойства –
решающие с точки зрения времени реакции, задержки или стабильности
алгоритмов, зависящих от времени, таких как системы с обратной связью.

Символ
Символ это имя, определенное пользователем согласно определенным
синтаксическим правилам. После того, как он определен (например, для
представления переменных, типов данных, меток переходов, блоков), его
можно использовать при программировании, мониторинге и управлении.

Пример: адрес : I5.0, тип данных: BOOL, символ: Emer stop.

Символическая адресация
Если данные адресуются с использованием символики,  адрес, связывающий
с процессом, задан символически (не так как при абсолютной адресации).
Символы назначаются адресам в таблице символов

Система последовательного управления
Система последовательного управления переключает с одного шага на
другой в зависимости от условий. В PCS 7, в качестве системы
последовательного управления применяются схемы SFC.

Смещение по фазе
Смещение по фазе переносит точку активации группы выполнения в
пределах задачи на определенное время, измеренное в единицах базового
цикла.  Фазовый сдвиг позволяет получить однородное во времени
распределение загрузки CPU. См. также отношение циклов.

Соединение
Это подключение входов и выходов блока или схемы к другим элементам.
Величина на подключенных входах поступает с другого конца соединения на
стадии выполнения.
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Справочные данные
Справочные данные схемы это данные доступные пользователю в
дополнение к графическому представлению схемы в форме списков,
например, списков доступов к глобальным адресам или иерархия вызова
блоков.

Страница переполнения
(CFC) Если имеется слишком так много связей листа, что они не помещаются
в панелях листа, автоматически создаются страницы переполнения.
Страница переполнения содержит только панель листа с вводами и не
содержит других объектов

Структура
Структура это тип данных, организованный из различных элементов. Сами
элементы могут иметь простой или структурированный тип данных.

Схема
В системе проектирования, схема, в зависимости от контекста, означает одно
из перечисленного ниже:

 Схема CFC содержит от 1 до 26 разделов, каждый с 6 листами и
возможным переполнением страниц.

 Вложенная схема - результат вставки одной схемы в другую (схема в
схеме).

 В схеме SFC содержится от 1 максимум до 8 таблиц. Каждая таблица
содержит последовательность.

Т

Таблица символов
Таблица для назначения символов (= имен) для адресации в глобальных
данных и блоках.
Примеры: Символ Адрес

Emer stop I1.7,
Control FB24
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Тег процесса
Схема CFC ориентируется на основное управление процессом,
применительно к его специфической функции управления, например,
управления уровнем. Тег процесса может создаваться копированием типа
тэга процесса с дальнейшей настройкой под требования специфической
задачи.

Тестовый режим

(Альтернатива к режиму редактирования) Режим CFC/SFC для тестирования
и оптимизации программы пользователя на CPU в интерактивном режиме

Технологический вид

Представление в SIMATIC Manager, основанное на технологических аспектах
(установка, модуль, функция ...); альтернатива к компонентному виду или
виду объектов процесса

Тип блока
Тип блока - готовый раздел программы, который можно использовать в схеме
CFC (например, контроллеры, мультиплексоры и т.д.). Когда он вставляется,
создается экземпляр блока. Вы можете создать произвольное число
экземпляров одного типа блоков.

Тип блока определяет характеристики (алгоритм) для всех реализаций
данного типа. Имя блока определяется в символьной таблице.

Тип данных
Тип данных определяет, как используется величина переменной или
константы на входе или выходе блока. Например, “BOOL“ определяет
бинарную переменную, а “INT“ определяет 16-битную переменную с
фиксированной точкой.

У

Указатель установки схемы
Указатель установки разрешает следующую точку для установки в
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последовательность исполнения. Имеются указатель установки схемы
(установки группы исполнения в схему) и указатель установки блока
(установка блоков).

Установка и ввод в эксплуатацию
Редактор CFC/SFC предусматривает тестовые функции, обеспечивающие
Вас возможностью наблюдать, модифицировать и изменять установку
параметров в PLC в процессе установки и ввода в эксплуатацию.

Устройство программирования (PG)
Портативный и компактный персональный компьютер специально
сконструированный для использования в промышленных условиях.
Программатор полностью оборудован для программирования контроллеров
SIMATIC.

Ф

Функция (FC)
(FUNCTION) В соответствии с IEC 1131-3, функция – логический блок без
памяти. Функции могут передавать параметры в пользовательскую
программу.  Функции подходят для часто встречающихся сложных функций,
например, вычислительных.

Функциональный блок (FB)
(FUNCTION BLOCK) В соответствии с IEC 1131-3, функциональный блок –
логический блок со статическими данными. FB могут передавать параметры в
пользовательскую программу. Функциональные блоки подходят для часто
встречающихся сложных функций, например, управления с обратной связью.
Поскольку FB имеет память (экземплярный блок данных), его параметры
(например, выходы) могут быть доступны в любое время и в любом месте
программы.
См. также  - категории блоков

Ц

Цикл обновления
В тестовом режиме так обозначается интервал времени, с которым
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обновляются наблюдаемые входы и выходы блоков.

Э

Экземпляр блока
Экземпляр блока - реализация типа блока. Тип блока вставленный в схему
CFC становится  экземпляром блока. Когда он вставляется, экземпляру блока
назначаются свойства для времени исполнения (run-time) и дается имя
уникальное в пределах данной схемы.

CFC
Непрерывная функциональная схема.

1. Функциональная схема (схема CFC) с графическим соединением
технологических функций (блоков).

2. Редактор для графического конфигурирования задач автоматизации
ориентированного на комплексное решение. Использование CFC
позволяет создать из готовых блоков структуру программного
обеспечения в целом (схема CFC).

CPU
CPU (центральный процессор) - модуль программируемого контроллера, в
котором хранится и выполняется пользовательская программа. Он содержит
операционную систему и коммуникационные интерфейсы.

ES
Сокращение от "Engineering System" ("Система разработчика"). Конфигурация
системы, на которой может быть удобно и с визуальной поддержкой создана
и настроена система управления технологическим процессом.

OS
Операторская станция. Станция для наблюдения и управления
технологическим процессом. В PCS 7 в качестве OS используется
программное обеспечение WinCC, с помощью которого реализуются все
задачи мониторинга и управления процессом.
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PLC
PLC используется как общий термин для устройства, содержащего CPU, в
котором выполняется пользовательская программа. В нашем случае, он
включает программируемые контроллеры S7 и автоматические компьютеры
M7.

SCL
Язык программирования высокого уровня, похожий на Pascal,
предусмотренный IEC 1131-3, для программирования комплексных решений
для PLC, например, алгоритмов и задач обработки данных.

SFC
Схема SFC – система последовательного управления, которая выполняется
как отдельная управляющая система в программируемом контроллере.

SIMATIC Manager
Графический интерфейс пользователя для пользователей SIMATIC под
Windows 95/98/NT/2000/XP. SIMATIC Manager используется, например, для
создания проектов и доступа к библиотекам

Online/Offline
В SIMATIC Manager объекты программируемого контроллера представимы в
виде online, а объекты ES в виде offline. Online требует связи PLC и
программатора, offline не требует.

.
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